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Context sensitive help can be accessed from within ImageAXS by using the F1 key from any 
dialog or menu.



Help Instructions

You can find information in Help by using the Help Contents or the Search feature. To return 
to the Help Contents after you read the instructions below, click the CONTENTS button or 
press the C key.

For complete instructions on how to use Help, return to the Help Contents and press the F1 
key.

To access Help from within ImageAXS:
- Press F1 from a dialog or menu.
- Choose the Help button in a dialog box. 

To use the Help Contents, do one of the following:
- Click an underlined topic.
- Press the TAB key until you highlight the topic you want, and then press the ENTER 

key.
To scroll in the Help window, do one of the following:

- Use the up and down arrows on your keyboard.
- Use the page up and page down keys on your keyboard.
- Use the scroll bars with the mouse.

To return to the previous topic:
- Click the BACK button or press the B key.

To open the Search feature in Help:
- Click the SEARCH button or press the S key.

To close the Help window:
- Choose EXIT from Help's File menu (ALT, F, X).



Welcome to ImageAXS

ImageAXS is a single-user application that assists you in your work with visual media. It is an
imagebase - a database that enables you to catalog, retrieve, and display images.

With ImageAXS, you create collections that contain information about source files, but do 
not contain the actual source files themselves. When you acquire a source file, ImageAXS 
automatically creates a smaller version of the full size source image. This smaller image is 
called a thumbnail and is stored, along with file information about the source file (file type, 
size, location, etc.), in a record within your collection. In addition to file information, 
ImageAXS provides eight user-modifiable text fields, including a 32,000 character field, and 
keywords. If a source file includes text in the form of a caption, ImageAXS automatically 
enters that information into the large text field. The file information, user-modifiable fields, 
and keywords are all searchable.

You may create as many collections as you like with ImageAXS, each containing records of 
diverse file types. The source files may be located anywhere. No matter where the source 
file is located, on your local hard drive, on removable media (floppy disks, Syquests, CD-
ROMs, etc.), or on remote volumes (servers or networked storage devices), ImageAXS 
remembers where the file is. Every view of the information within ImageAXS tells you at a 
glance if the source file is available (on-line) or not. Information about the source file can be 
displayed, regardless of whether it is on-line or off-line. If the source file is on-line, the 
source image itself can be displayed, regardless of size, location or format, without the need 
to launch another application.

ImageAXS also enables you to create projects. Projects allow you to create and save subsets 
of your collections. Placing records in a project does not remove them from the collection or 
change their physical location at all. It simply tags them as belonging to a specific group and
allows them to be displayed quickly and easily.

The monitoring feature in ImageAXS enables you to view a directory of files without 
acquiring those files into a collection. Monitoring means viewing the 'real-time' contents of a 
directory. Any changes to the contents of the directory that you are monitoring are reflected 
in the monitor window.

Your images look better in ImageAXS.
__________
See Also

Customer Support
Starting ImageAXS
ImageAXS Basics



Customer Support

DCI is committed to helping you increase your productivity by getting the most out of 
ImageAXS. If you are unable to find the answers to your questions in this help system, 
please contact DCI's Customer Support Department by phone at 510-814-7200, by fax at 
510-814-6100, or via America Online at "DIGICOL." Support is available Monday through 
Friday between the hours of 9:00 a.m. and 5:00 p.m. Pacific Time. After hours you may leave
messages on DCI's voice mail by dialing 510-814-7200 and pressing 1 when prompted.

In Europe, call New Media Solutions at 0171 727 9727. Support is available Monday through 
Friday between the hours of 9:30 A.M. and 18:00 P.M. BST.



Starting ImageAXS

Once you have installed ImageAXS, simply double click the ImageAXS application icon to 
start ImageAXS. If you are starting ImageAXS for the first time, you will have to register 
ImageAXS before you can use the application.

When you start ImageAXS, the application automatically uses the date format determined 
by the setting in the International control panel. For instance if you are in England, October 
31, 1993 would be written as 31/10/93. This is true for all dates within ImageAXS including 
the format of the date box in the Full Search dialog.
__________
See Also

Registering ImageAXS
Opening A Collection
Quitting ImageAXS



Date Formats

When you start ImageAXS, the application automatically checks Windows to determine what
country your system is set for and then adjusts all date formats within ImageAXS 
accordingly. For instance if you are in England, October 31, 1993 would be written as 
31/10/93. This is true for all dates within ImageAXS including the format of the date box in 
the Full Search dialog.
__________
See Also

Full Search



Registering ImageAXS

If you are running ImageAXS for the first time, a registration dialog appears as soon as you 
start the application. 

To register ImageAXS:
1. Type in your name, your company's name, and your registration number. 

Your registration number is provided on stickers packaged with ImageAXS. Attach one
sticker to your registration card and return it to DCI to activate 90 days of support. 
Attach the second sticker to the user's guide for future reference.

2. Click the OK button.

__________
See Also

Opening A Collection
Quitting ImageAXS



Opening the Sample Collection

When you open ImageAXS, the Open dialog automatically appears. If you are opening 
ImageAXS for the first time, the only collection available for you to open is the sample 
collection The sample collection is only available if you chose to install it with the 
application.

To open the sample collection:
1. Locate the sample collection (axs.col) in the SAMPLES directory within the 

ImageAXS directory you created during installation (default: C:\IMAGEAXS).

2. Click the sample collection to highlight it, and click the OK button.

This opens the sample collection. Notice that there is a red "X" over the disk icon beneath    
each image in the collection. This means that the source file for each record is off-line. (i.e., 
the application does not know where to find the source files from which the records were 
created.) Updating the records in the sample collection will place all of the source files back 
on-line and remove the red X's.

To update the sample collection:
1. Choose SELECT ALL from the Edit menu.

This highlights all of the records in the collection in red.
2. Select UPDATE from the Record menu.

The Update dialog appears.
3. Uncheck the THUMBNAIL option.

This option is located directly above the SKIP button.
4. Locate and select the SAMPLES directory within the ImageAXS directory 

you created during installation (default: C:\IMAGEAXS).
This tells ImageAXS where to look for the source files.

5. Click the OK button.
A progress dialog in the status bar at the bottom of your collection reflects the progress 
of the update.
All of the source files for the sample collection are now on-line.

__________
See Also

Updating Records
Opening A Collection



Opening A Collection

If you have never used ImageAXS on the computer on which it is currently installed ( i.e. you
have not run a prior version or a demo version) a dialog appears when you start the 
application prompting you to select a collection to open. If you have previously used a 
version of ImageAXS on the computer on which it is currently installed, the collection and/or 
the monitor window that was open the last time you quit ImageAXS automatically open. The 
collection and and/or the monitor window that are open when you quit ImageAXS will always
open when you start ImageAXS again. If you close the collection and the monitor windows 
before exiting or if ImageAXS cannot locate the collection that was open last, the open 
dialog appears prompting you to select a collection to open.

To open a collection:
1. Locate the collection you want to open.

If you are starting ImageAXS for the first time, the only collection available is the 
sample collection that comes with the application (the sample collection is only 
available if you chose to install it when installing ImageAXS). The sample collection is 
called: axs.col.

2. Select the collection you want to open by clicking it.

3. Click the OK button.

If you are starting ImageAXS for the first time, the only collection available is the sample 
collection that comes with the application. The sample collection is only available if you 
selected to install it with the application. 

Any time you start ImageAXS and the Open dialog appears, you can either locate and select 
a collection to open or you can click the CANCEL button. This closes the dialog and leaves 
you with an empty application window from which you can create a new collection.
__________
See Also

Opening the Sample Collection
Creating A New Collection



Quitting ImageAXS

To quit ImageAXS, select EXIT from the File menu. If there are any open projects with 
unsaved changes, you are prompted to save them.

__________
See Also

Exit Command



Menu Commands

File Menu
New
Open
Close
Collection Info
Export
Import
Print
Print Setup
Check Volumes
Exit

Edit Menu
Undo
Cut
Copy
Paste
Show Clipboard
Launch Editor
Select All
Invert Selection
Clear Selection
Keywords
Preferences

Record Menu
New
Save
Revert
Remove
Acquire New Images
Copy Source Files
Move Source Files
Rename
File Info
Update
Delete Source Files

Browse Menu
Search
Keyword Search
Sort



Show All
Show Selection
SlideShow
Go To
First
Previous
Next
Last

Project Menu
New
Open
Close
Save
Save As
Add To
Remove

Monitor Menu
Open
Close
Refresh
Acquire
Show Caption

View Menu
Fit Window To View
Thumbnails
Text List
Info Sheet
Keywords
Source Image
Zoom In
Zoom Out
Scale Image to Window
Status Bar
Toolbar

Window Menu
Cascade
Tile
Arrange Icons
1,2,3.....



New Command

Use this command to create a new collection. Only one collection may be open at a time. In 
order to create a new collection, any open collection must first be closed.

Shortcut
Keyboard: ALT+F+N

Dialog Options:

File Name

Type the name that you want to give the collection you are creating.
Save File as Type

Type or select the name of the file type that you want to save the collection as. The 
default file type is: Database Files (*.COL).

Directories

Select the directory in which you want to save the new collection.
Drives

Select the drive in which you want to save the new collection.
__________
See Also

Creating A New Collection
Opening An Existing Collection
Closing A Collection



Open Command

Use this command to open an existing collection. Only one collection may be open at a time.
In order to open a collection, any open collection must first be closed.

Shortcuts:
Keyboard: CTRL+O

ALT+F+O

Dialog Options:

File Name

Type or select the name of the collection that you want to open.
Save File as Type

Type or select the type of file that you want to open. The default file type is: 
Database Files (*.COL).

Directories

Select the directory in which the collection you want to open is stored.
Drives

Select the drive on which the collection you want to open is stored.
__________
See Also

Opening An Existing Collection
Closing A Collection



Close Command

Use this command to close the collection that is currently open. Only one collection may be 
open at a time. In order to open another collection, you must first close the one that is 
currently open.

Shortcuts:
Keyboard: ALT+F+C

__________
See Also

Opening An Existing Collection
Closing A Collection



Collection Info Command

Use this command to open the Collection Information dialog for the collection that is 
currently open. The Collection Information dialog is available so that you may enter general 
information about an entire collection. You may enter text (up to 32,000 characters) or edit 
text that has already been entered.

Shortcuts:
Keyboard: ALT+F+I

__________
See Also

Viewing and Editing Collection Information



Export Command

Use this command to create an export file containing records and collection information from
one of your collections. Export files created by ImageAXS can only be read by ImageAXS 
(Macintosh or Windows). Exporting does not remove records from the collection from which 
you are exporting, it just copies the information to an intermediate file which can then be 
imported by ImageAXS.

Shortcuts:
Keyboard: ALT+F+E

Dialog Options:

File Name

Type a name for the export file you are creating.
Save File as Type

Type or select the type of file that you want create. The default file type is: Export 
Files (*.AXS).

Directories

Select the directory in which the export file to be saved.
Drives

Select the drive on which you want the export file to be saved.
__________
See Also

Importing and Exporting Records
Cross Platform Importing and Exporting



Import Command

Use this command to import records into a collection from ImageAXS export files. Only 
records that have been exported from ImageAXS can be imported.

Shortcuts:
Keyboard: ALT+F+M

Dialog Options:

File Name

Type or select the name of the export file that you want to import.
Save File as Type

Type or select the type of file that you want to open. The default file type is: Export 
Files (*.AXS).

Directories

Select the directory in which the export file you want to import is stored.
Drives

Select the drive on which the export file you want to import is stored.
__________
See Also

Importing and Exporting Records
Cross Platform Importing and Exporting
Import Mapper



Print Command

Use this command to open the Print dialog. From the Print dialog you can: Select a print 
format, Print all of the records in the active window, Print only the records you have selected
in the active window, and/or view a preview of how your records will look when you print 
them.

Shortcuts:
Toolbar:
Keyboard: CTRL+P

ALT+F+P

Dialog Options:

Thumbnails

Select this option if you want print output in the Thumbnails format.
Text List

Select this option if you want print output in the Text List format.
Source Image

Select this option if you want print output in the Source Image format.
All Records

Select this option if you want to print all of the records in the active window.
Selected Records

Select this option if you only want to print those records that you have selected in the
active window.

Preview

Displays the Print Preview dialog which allows you to see how your records will look 
when you print them out.

__________
See Also

Printing
Print Preview



Print Setup Command

Use this command to open the Print Setup dialog. The Print Setup dialog allows you to set all
printing options.

Shortcuts:
Keyboard: ALT+F+R

__________
See Also

Print Setup



Check Volumes Command

Use this command to update the on-line /off-line information for the collection you are 
currently viewing.

Each record in each view in ImageAXS shows whether or not the source image is on-line or 
off-line. The Check Volumes feature allows you to check to make sure that the on-line/off-line
information on your screen is up to date. Each time you change disks or mount or dismount 
a volume, you should use Check Volumes to update your information.

Shortcuts:
Keyboard: ALT+F+V

__________
See Also

Disk Icons



Exit Command

Use this command to exit ImageAXS. If there are any projects open that have changed since 
they were created and have not been saved, you are prompted to save them.

Shortcuts:
Keyboard: ALT+F+X

__________
See Also

Quitting ImageAXS
Saving A Project



Undo Command

Use this command to reverse the last text editing action, if possible. The UNDO command 
changes to CAN'T UNDO on the menu if you cannot reverse your last action.

Shortcuts:
Keyboard: CTRL + Z

ALT+E+U
ALT+BkSp



Cut Command

Use this command to remove selected text from a record and put it on the Clipboard. Cutting
text replaces any previous Clipboard contents. This command is unavailable of you have no 
selected text.

Shortcuts:
Keyboard: SHIFT+DEL

CTRL + X
ALT+E+T

__________
See Also

Entering Data



Copy Command

Use this command to access the Copy sub-menu:
Text
Record
Source Image



Copy Text Command

Use this command from the Copy sub-menu to copy selected text to the Clipboard. This 
command is unavailable if you have no selected text or graphics. Copying text to the 
clipboard replaces any contents previously stored there. This command is unavailable if no 
text is selected.

Shortcuts:
Keyboard: ALT+E+C+T

CTRL+INS
CTRL+C

__________
See Also

Entering Data
Copying Images to the Clipboard
Copying and Pasting Records



Copy Record Command

Use this command from the Copy sub-menu to copy the keywords and all of the text from 
the eight user definable fields in the selected record to the Clipboard. This command is 
unavailable if no record is selected or if more than one record is selected.

Shortcuts:
Keyboard: ALT+E+C+R

__________
See Also

Copying and Pasting Records
Selecting Records
Paste Record Command



Copy Source Image Command

Use this command from the Copy sub-menu to copy the source image for the selected 
record to the Clipboard so that it can be pasted into an application other than ImageAXS. 
This command is unavailable if more than one record is selected.

To copy the actual source file to another location, use the Copy Source Files Command

Shortcuts:
Keyboard: ALT+E+C+S

__________
See Also

Copying Images to the Clipboard
Copy Source Files



Paste Command
Use this command to access the Paste sub-menu:

Text
Record



Paste Text Command

Use this command from the Paste sub-menu to insert text that has been copied to the 
Clipboard into a record. This command is unavailable if the Clipboard does not contain text.

Shortcuts:
Keyboard: SHIFT+INS

ALT+E+P+T
__________
See Also

Copy Command
Copying and Pasting Records



Paste Record Command

Use this command from the Paste sub-menu to paste data into multiple records. Data that 
has been copied to the Clipboard with the Copy Record Command can be pasted into the 
record or records in your selection, or you can copy a single field to the Clipboard and then 
paste that field into multiple records using the Paste Record Command. The Paste Record 
Command is unavailable if there is no text on the Clipboard.

Shortcuts:
Keyboard: ALT+E+P+R

__________
See Also

Copy Record Command
Copying and Pasting Records
Selecting Records



Show Clipboard Command

Use this command to display the Clipboard and any text or graphics it may contain.

Shortcuts:
Keyboard: ALT+E+S



Launch Editor Command

Use this command to open the source filefor the selected record in an application other than 
ImageAXS. This command is not available if more than one record is selected.

Launch Editor makes use of the Windows Associate feature which allows you to associate
certain applications with specific file types. For instance, Windows comes with an application
called Paintbrush that is automatically associated with .bmp files. Therefore if you select a 
record in ImageAXS whose source image is a .bmp and select LAUNCH EDITOR from the Edit 
menu, Paintbrush opens the source image and you can edit the image. You must associate 
applications to file types before the Launch Editor feature will work.

Shortcuts:
Mouse: CTRL+SHIFT+double click on the image you want to open.
Keyboard: ALT+E+L

__________
See Also

Launching An Image Editor



Select All Command

Use this command to select all records in the active window. This command is only available 
from the Thumbnails View and the Text List View.

Shortcuts:
Keyboard: CTRL+A

ALT+E+A
__________
See Also

Selecting Records



Invert Selection Command

Use this command to invert the current selection in the active window (i.e., select all of the 
records that are not currently selected and deselect all of the records that are currently 
selected).

Shortcuts:
Keyboard: ALT+E+I

__________
See Also

Selecting Records



Clear Selection Command

Use this command to deselect any selected records in the active window.

Shortcuts:
Keyboard: ALT+E+E

__________
See Also

Selecting Records



Keywords Command

Use this command to open the Keywords Dialog. The Keywords Dialog allows you to apply 
keywords to multiple records at one time. The number of records you are working with is 
given in the title bar of the Keywords Dialog.

Shortcuts:
Toolbar:
Keyboard: ALT+E+K

Dialog Options:

Master Keyword List

Type in a new keyword to be added to the Master Keyword List or select an existing 
keyword to be modified or added to the Working List

Create

Adds the keyword you have typed into the Master Keyword List field to the Master 
Keyword List.

Modify

Displays the Modify Keywords dialog which allows you to make changes to 
keywords that have already been added to the Master Keyword List.

Delete

Deletes selected keywords from the Master Keyword List.
Copy

Copies selected keywords from the Master Keyword List to the Working List.
Working List

Contains all of the keywords that you want to attach or detach from the records in 
your selection.

Attach

Attaches the keywords in the Working List to the records in your selection.
Detach

Removes the keywords in the Working List from the records in your selection.
Remove

Removes selected keywords from the Working List.
Common

Displays the Common Keywords dialog
Options

Displays the Keyword Options dialog.



Close

Closes the Keywords Dialog.
__________
See Also

Keywords Dialog
Keywords View



Preferences Command

Use this command to access the Preferences sub-menu:
Assigning Field Labels Command
Selecting A Thumbnail Label Command
Modifying System Settings Command
PhotoCD Options Command
Monitor Settings Command

__________
See Also

Setting Preferences



Assigning Field Labels Command

Use this command to open the Field Labels dialog. The Field Labels dialog allows you to 
name the eight user definable fields in the collection that is currently open.

Shortcuts:

Keyboard: ALT+E+F+L

Dialog Options:

Type the names of your choice into the desired fields.
__________
See Also

Assigning Field Labels
Preferences



Selecting A Thumbnail Label Command

Use this command to open the Thumbnail label dialog.

Shortcuts:

Keyboard: ALT+E+F+T

Dialog Options:

Database Fields

Select the field that you want to be displayed beneath each thumbnail in the 
collection.

__________
See Also

Selecting A Thumbnail Label
Setting Preferences



Modifying System Settings Command

Use this command to open the System Settings dialog.

Shortcuts:

Keyboard: ALT+E+F+S

Dialog Options:

Thumbnail Type

This option allows you to choose which type of thumbnails will be contained in your 
collection. Select one of the two options listed on the pop-down menu.

Thumbnail Cache Size

This option allows you to set how many thumbnails are kept in memory at one time. 
To set the Thumbnail Cache size, type in a number no greater than 128.
The default setting is 12 thumbnails.

Text Cache Size

This option allows you to set the number of records worth of text that is kept in 
memory at one time. To set the Text Cache size, type in a number no greater than 
256.
The default setting is 24 records.

Image Spool Threshold

This option allows you to set the level above which images are spooled into memory. 
To set the Image Spool level, type in a number.
The default setting is 2,000 K.

Color Mode

This option allows you to set the color scheme that will be used in ImageAXS. To 
select a color mode, choose an option from the pop-down menu.
The default setting is Light Grays.



PhotoCD Options Command

Use this command to open the PhotoCD Options dialog. The PhotoCD Options dialog allows 
you to choose the color mode and resolution for viewing PCD source images.

Shortcuts:
Keyboard: ALT+E+F+P

Dialog Options

Color Mode
Select a color mode for the image to be viewed.
Important! Selecting LAB COLOR will result in improperly displayed 
images.

Resolution
Select a resolution for the image to be viewed.

Always ask for PhotoCD Options
Select this option if you want the PhotoCD Options dialog to appear each time you 
attempt to display a PCD source image or copy it to the clipboard, If this option is not 
checked, the settings you select become the default settings for each PCD source 
image you view or copy to the clipboard.

OK
Closes the PhotoCD Options dialog and implements your changes.

Cancel
Closes the PhotoCD Options dialog without implementing your changes.

__________
See Also

PhotoCD Options
Supported File Types



Monitor Settings Command

Use this command to set the cache size and monitoring frequency for the monitor window, 
determine which types of files are displayed in the monitor window, and set options for 
acquiring images from the monitor window.

Shortcuts:
Keyboard: ALT+E+F+M

Dialog Options

Cache Size
Type in the number of images you want ImageAXS to cache into memory for the 
monitor windows.

Frequency
Type in the frequency with which you want the monitor windows to check the folders 
they are monitoring. The frequency is measured in seconds.

Filter out non-image files
Select this option if you want only image files to appear in the montor window.

Move Source Images to:
Select this option if you want to move source files when you acquire them from the 
monitor window.

Collection Directory
Select this option to move the source files to the dirctory containing the collection 
into which you are acquiring the files.

Custom Directory
Select this option to move the source files to a directory of your choice. The current 
directory selection is displayed directly beneath this option.

Change
Click this button if you have selected CUSTOM DIRECTORY and you want to change 
the directory into which the source files are to be moved.

OK
Closes the Monitor Settings dialog and implements your changes.

Cancel
Closes the Monitor Settings dialog without implementing your changes.

__________
See Also

Monitor Settings
Monitoring



New Command

Use this command to create new records without acquiring a source file. This is useful if you 
want to enter data before the images are available. Source files can be added to these 
records later with the Update feature.

Shortcuts:
ToolBar:
Keyboard: CTRL+N

ALT+R+N
__________
See Also

Creating Blank Records
Entering Data
Updating Records
Update Command



Save Command

Use this command to save changes you have made to the text data in a record.

This command is only available from the Info Sheet View.

Shortcuts:
Toolbar:
Keyboard: CTRL+S

ALT+R+S
__________
See Also

Saving A Record
Entering Data



Revert Command

Use this command to return the current record to its last saved state. For example, if you 
make changes to the text data in a record but you have not yet saved those changes, you 
can use the revert command to remove all of the changes you have made.

This command is only available from the Info Sheet View.

Shortcuts:
Keyboard: ALT+R+V

__________
See Also

Saving A Record
Entering Data



Remove Command Project

Use this command to remove the selected records from the collection. This command does 
not delete the source files for the selected records.

Shortcuts:

Keyboard: ALT+R+R



Acquire New Images Command

Use this command to acquire new images into your collection.

Shortcuts:
Keyboard: ALT+R+A

Dialog Options:

File Name

Select the files you want to acquire.
List Files of Type

Type or select the type of files that you want displayed in the File Name list. The 
default file type is: Image Files.

Directories

Select the directory in which the file(s) you want to acquire are located.
Drives

Select the drive on which the file(s) you want to acquire are located.
Acquire Log

Keeps track of the files you want to acquire.
Add

Adds the file(s) you have selected in the File Name field to the Acquire Log.
Add All

Adds all of the image files in the directory you have selected to the Acquire Log.
Remove

Removes selected file(s) from the Acquire Log.
OK

Acquires all of the files listed in the Acquire Log into the open collection
__________
See Also

Creating Records



Copy Source Files Command

Use this command to copy source files from one location to another.

Shortcuts:
Keyboard: ALT+R+C

Dialog Options:

Source Files

Lists the location of each source file that you have chosen to copy.
Destination

Lists the location to which the files will be copied.
Change

Opens the Choose Directory dialog that allows you to choose the location to which 
the files will be copied.

Change Database References

Check this option to switch your database references from the original files to the copied 
files.
__________
See Also

Copying Source Files
Moving Source Files



Move Source Files Command

Use this command to move source files from one location to another.

Shortcuts:
Keyboard: ALT+R+M

Dialog Options:

Source Files

Lists the location of each source file that you have chosen to move.
Destination

Lists the location to which the files will be moved.
Change

Opens the Choose Directory dialog that allows you to choose the location to which 
the files will be moved.

__________
See Also

Moving Source Files
Copying Source Files



Rename Command

Use this command to change the file name of the source file for the selected  record. This 
command is not available if more than one record is selected.

Shortcuts:
Keyboard: ALT+R+E

Dialog Options:

File Name

Type in a new name for the source file.
Save File as Type

Type or select the type of file that you want create. The default file type is: Image 
Files.

Directories

Select the directory in which to save the renamed file.
Drives

Select the drive on which to save the renamed file.
__________
See Also

Renaming a Source File



File Info Command

Use this command to open the File Information dialog. The File Information dialog lists 
specific information about the source file for the selected record. This command is not 
available if more than one record is selected.

Shortcuts:
Toolbar:
Keyboard: CTRL+I

ALT+R+F
Mouse: Double click on a disk icon to bring up the file information for that 

specific record.



Update Command

Use this command to Update a record or a group of records.

Shortcuts:
Keyboard: ALT+R+U

Dialog Options:

File Name

Type or select the name of the file you want to update.
List Files of Type

Type or select the type of files that you want displayed in the File Name list. The 
default file type is: Image Files.

Directories

Select the directory in which the correct source file(s) are located.
Drives

Select the drive on which the correct source file(s) are located.
Thumbnail

Check this checkbox if you want to create a new thumbnail for each record that is 
updated.

Update All

Check this checkbox if you want to update all records for which a source file can be 
found. This option is only available if you have selected more than one record to 
update.

Skip

Skips the current record and attempts to locate and update the next record. This 
option is only available if you have selected more than one record to update.

__________
See Also

Updating Records



Delete Source Files Command

Use this command to delete the source files for the selected records.

Shortcuts:
Keyboard: ALT+R+D

__________
See Also

Deleting Source Files



Search Command

Use this command to open the Search dialog.

Shortcuts:
Toolbar:
Keyboard: CTRL+F

ALT+B+E

Dialog Options:

Fields

Select the field that you want to search.
Comparators

Select the comparator you want to use.
Value

Type in the specific value you want to search for or, if you have chosen to search the 
Keywords field, select the keyword you want to search for.

Search List

Displays all of the search lines from the current search.
And

Select this option if your search is longer than one line and you want to link two of 
your search lines with AND.
AND is the default connector when you add lines to your search; however, you can 
change any AND to an OR.

Or

Select this option if your search is longer than one line and you want to link two of 
your search lines with OR.

Add Line

Adds a line to your search.
Clear Line

Deletes the selected line from your search.
Clear All

Deletes all lines from your search.
History

Opens the Search History dialog from which you may select a search.
Create New Project



Select this option to create a project containing the results of your search. If this 
option is not selected, the search results are displayed in the collection window.

Search Active Window

Select this option to include only those records in the active window in your search. If 
this option is not selected, the search includes all records in the collection.

__________
See Also

Full Search



Keyword Search Command

Use this command to open the Keyword Search dialog.

Shortcuts:
Toolbar:
Keyboard: ALT+B+K

Dialog Options:

Master Keywords List

Select the keywords that you want to search for.
And

Select this option if you want to search for only those records that contain all of the 
keywords you have chosen from the Master Keywords List.

Or

Select this option if you want to search for those records that contain any one or 
more of the keywords you have chosen from the Master Keyword List.

Create New Project

Select this option to create a project containing the results of your search. If this 
option is not selected, the search results are displayed in the collection window.

Search Active Window

Select this option to include only those records in the active window in your search. If 
this option is not selected, the search includes all records in the collection.

__________
See Also

Keyword Search



Sort Command

Use this command to open the Sort dialog.

Shortcuts:
Toolbar:
Keyboard: ALT+B+O

Dialog Options:

Fields

Select the field you want to sort.
Ascending

Select this option if you want to sort the data in the sort field in ascending order (a-z 
or 1-100).

Descending

Select this option if you want to sort the data in the sort field in descending order (z-a
or 100-1).

__________
See Also

Sorting



Show All Command

Use this command to replace the contents of the active window with the entire contents of 
the collection.

Shortcuts:
Keyboard: ALT+B+A



Show Selection Command

Use this command to reduce the contents of the active window to only those records that 
are selected.

Shortcuts:
Keyboard: ALT+B+W



SlideShow Command

Use this command to open the SlideShow dialog.

Shortcuts:
Keyboard: ALT+B+S

Dialog Options:

Interval

Type in the number of seconds you want to pause between images during the 
SlideShow.

Forward

Select this option if you want the SlideShow to cycle forward through the records in 
your collection.

Backward

Select this option if you want the SlideShow to cycle backward through the records in 
your collection.

Continuous Loop

Select this option if you want the SlideShow to run in a continuous loop ending only 
when you stop it.



Go To Command

Use this command to open the Go To dialog.

Shortcuts:
Keyboard: ALT+B+G

Dialog Options:

Record Position

Type in the number of the record you want to move to.



First Command

Use this command to move to the first record or page of records in the active window.

Shortcuts:
Toolbar:
Keyboard: CTRL+UP

ALT+B+F



Previous Command

Use this command to move to the previous record or page of records in the active window.

Shortcuts:
Toolbar:
Keyboard: CTRL+LEFT

ALT+B+P



Next Command

Use this command to move to the next record or page of records in the active window.

Shortcuts:
Toolbar:
Keyboard: CTRL+RIGHT

ALT+B+N



Last Command

Use this command to move to the last record or page of records in the active window.

Shortcuts:
Toolbar:
Keyboard: CTRL+DOWN

ALT+B+L



New Command Project

Use this command to create a new project.

Shortcuts:
Keyboard: ALT+P+N

__________
See Also

Creating A New Project



Open Command Project

Use this command to open an existing project.

Shortcuts:
Keyboard: ALT+P+O

Dialog Options:

File Name

Type or select the name of the project that you want to open.
List File as Type

Type or select the type of file that you want to open. The default file type is: Project 
Files (*.PRJ).

Directories

Select the directory in which the project you want to open is stored.
Drives

Select the drive on which the project you want to open is stored.
__________
See Also

Opening An Existing Project



Close Command Project

Use this command to close the currently active project.

Shortcuts:
Keyboard: ALT+P+C



Save Command Project

Use this command to save a project.

Shortcuts:
Keyboard: ALT+P+S

Dialog Options:

File Name

Type a name for the project you are creating.
Save File as Type

Type or select the type of file that you want to create. The default file type is: Project 
Files (*.PRJ).

Directories

Select the directory in which the project is to be saved.
Drives

Select the drive on which you want the project to be saved.
__________
See Also

Saving A Project



Save As Command Project

Use this command to save an existing project with a new name.

Shortcuts:
Keyboard: ALT+P+A

Dialog Options:

File Name

Type a name for the project you are creating.
Save File as Type

Type or select the type of file that you want to create. The default file type is: Project 
Files (*.PRJ).

Directories

Select the directory in which the project is to be saved.
Drives

Select the drive on which you want the project to be saved.
__________
See Also

Saving A Project



Add To Command Project

Use this command to add selected records to a project.

Shortcuts:
Keyboard: CTRL+T

ALT+P+T

Dialog Options:

Select Project

Select the project to which you want to add the records. Creating a new project is an 
option.

__________
See Also

Adding Records to a Project



Remove Command Project

Use this command to remove the selected records from the active project.

Shortcuts:
Keyboard: ALT+P+R



Open Command Monitor

Use this command to open the monitor window.

Shortcuts:
Keyboard: ALT+M+O

Dialog Options:

List File as Type

Type or select the type of file that you want to open. The default file type is: Image 
Files.

Directories

Select the directory in which the directory you want to monitor is located.
Drives

Select the drive on which the directory you want to monitor is located.
__________
See Also

Opening the Monitor Window
Monitoring
Monitor Settings



Close Command Monitor

Use this command to close the monitor window.

Shortcuts:
Keyboard: ALT+M+C

__________
See Also

Closing the Monitor Window
Monitoring



Refresh Command Monitor

Use this command to update the monitor window. If the contents of the monitor window are 
incorrect (e.g., as a result of renaming or moving files or directories outside of ImageAXS) 
you can update the contents of the monitor window with the Refresh command. The Refresh 
feature also allows you to do manual monitoring if you do not wish to have the automatic 
monitoring turned on.

Shortcuts:
Keyboard: ALT+M+R

F5
__________
See Also

Monitoring
Monitoring a Directory
Updating the Monitor Window



Acquire Command Monitor

Use this command to acquire the images you have selected in the monitor window into the 
open collection.

Shortcuts:
Keyboard: ALT+M+A

__________
See Also

Acquiring Files from the monitor window
Monitoring



Show Caption Command

Use this command to display the caption for the selected record. This command is only 
available if a single image is selected.

Shortcuts:
Keyboard: ALT+M+S

__________
See Also

Viewing Captions
Monitoring



Fit Window to View Command

Use this command to size the application window to fit the current view.

Shortcuts:
Keyboard: CTRL+R

ALT+V+V



Thumbnails Command

Use this command to switch the view in the active window to the Thumbnails View.

Shortcuts:
Toolbar:
Keyboard: ALT+V+N

__________
See Also

Views
Thumbnails View



Text List Command

Use this command to switch the view in the active window to the Text List View.

Shortcuts:
Toolbar:
Keyboard: ALT+V+T

__________
See Also

Views
Text List View



Info Sheet Command

Use this command to switch the view in the active window to the Info Sheet View.

Shortcuts:
Toolbar:
Keyboard: ALT+V+I

__________
See Also

Views
Info Sheet View



Keywords Command

Use this command to switch the view in the active window to the Keywords View.

Shortcuts:
Toolbar:
Keyboard: ALT+V+K

__________
See Also

Views
Keywords View



Source Image Command

Use this command to switch the view in the active window to the Source Image View.

Shortcuts:
Toolbar:
Keyboard: ALT+V+S

__________
See Also

Views
Source Image View



Zoom In Command

Use this command to zoom in a source image in the Source Image View. This command is 
only available from the Source Image View.

Shortcuts:
Keyboard: CTRL+PLUS

ALT+V+Z
__________
See Also

Source Image View
Zooming In and Out



Zoom Out Command

Use this command to zoom out on a source image in the Source Image View. This command 
is only available from the Source Image View.

Shortcuts:
Keyboard: CTRL+MINUS

ALT+V+O
__________
See Also

Source Image View
Zooming In and Out



Scale Image to Window Command

Use this command to scale a source image to that largest size that will fit into the current 
window. This command is only available from the Source Image View.

Shortcuts:
Keyboard: ALT+V+W

__________
See Also

Source Image View
Automatic Scaling



Status Bar Command

Use this command to display or hide the status bar.

Shortcuts:
Keyboard: ALT+V+A

__________
See Also

Status Bar



Toolbar Command

Use this command to display or hide the toolbar.

Shortcuts:
Keyboard: ALT+V+B

__________
See Also

Toolbar



Cascade Command

Use this command to arrange open windows so that the title bar of each window is visible.

Shortcuts:
Keyboard: ALT+W+C

SHIFT+F5



Tile Command

Use this command to arrange open windows side by side so that all of them are visible.

Shortcuts:
Keyboard: ALT+W+T

SHIFT+F4



Arrange Icons Command

Use this command to arrange into rows all program-item icons for a selected group or, if a 
group icon is selected, arranges all group icons into rows.

Shortcuts:
Keyboard: ALT+W+A



1,2,3.....

Use this command to view the names of the open collection and all of the open projects. To 
view the collection window or a specific project window, select its name from this list.
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Collections

Collections are the documents created and read by ImageAXS. Each collection is an 
imagebase made up of individual records. ImageAXS allows you to create and maintain as 
many different collections as you like; however, only one collection can be open at a time.
__________
See Also

Creating and Working with Collections



Projects

Projects allow you to create and save subsets of your collections. Placing records in a project
does not remove them from the collection or change their physical location at all. It simply 
tags them as belonging to a specific group and allows them to be called up quickly and 
easily.

Each project is saved as a file associated with a specific collection. This means that a project
can only contain records from one collection and that a project can only be open when the 
collection to which it is associated is open.

A project window functions almost exactly like a collection window. There are, however, 
three differences:

1. You can open as many projects as you want as long as they are all 
associated with the open collection. In fact all windows that you open or 
create, other than the collection window or the monitor window, are project
windows.

2. The records in a project window are saved in the order in which you place 
them. The order of the records in a collection window is not saved unless 
you save a sorted collection as a project. When you open a collection, the 
records are always in the order in which they were acquired. 

3. A saved project always opens to the view that you were using when you last
saved the project. The collection window always opens to the Thumbnails 
View.

The same views are available for displaying records in a project window as in a collection 
window, and all features of each view are available from the project.

If you make any changes to the records in the project window (update, new record, rename, 
etc.), the changes are automatically reflected in the collection window. The one exception to 
this is that removing a record from a project does not remove it from the collection window; 
however, if you remove a record from a collection it is automatically removed from all 
projects.
__________
See Also

Creating and Working with Projects



Records

Each collection or project you create is made up of individual records. A record contains 
information about a single source file. To create a record, you must select a source file and 
'acquire' it. 

Each record contains: A thumbnail
File information
Text data
Keywords

__________
See Also

Creating Records
Managing and Manipulating Records



Views

ImageAXS provides many different ways to look at the records in your collections and 
projects. These are called views. There are 5 different views in ImageAXS:

Thumbnails View
Text List View
Info Sheet View
Keywords View
Source Image View

The Thumbnails View and Text List View are multiple record views that display multiple 
records at a time. The Info Sheet View, Keywords View, and Source Image View are single 
image views that display one record at a time.



Monitoring

The monitoring feature allows you to open a monitor window in which you can view a 
directory of files without acquiring those files into a collection. You can, however, select files 
from the monitor window to be acquired into a collection.

The monitor window reflects the 'real-time' contents of the directory you are monitoring. 
Therefore, it can only display thumbnails for those image files in the directory that already 
contain thumbnails. Any changes to the contents of the directory (e.g., files are added or 
removed) are reflected in the monitor window. 



Toolbar

 

The Toolbar is displayed across the top of the application window, below the menu bar. The 
Toolbar provides quick mouse access to all views and several key features used in 
ImageAXS. To hide or show the toolbar, select TOOLBAR from the View menu.
__________
See Also

Toolbar Icons
Toolbar Command



Status Bar

The Status Bar is displayed at the bottom of the application window. The status bar displays 
messages to help you use ImageAXS. To hide or show the status bar, select STATUS BAR 
from the View menu.



Disk Icons

Four of the five views in ImageAXS display a disk icon with each record. The disk icon 
indicates whether or not the source file for that record is on-line or off-line. The terms on-line
and off-line refer to whether or not ImageAXS is able to locate the source file for a record. 
For a source file to be on-line, ImageAXS must be able to locate it. If a source file has been 
moved or renamed outside of ImageAXS, it will be off-line because ImageAXS cannot locate 
it. In order for ImageAXS to work with an image (display it, copy it, rename it, etc.), the 
source file for that image must be on-line.

If a disk icon has a red X through it, the source file for that record is off-line. 
Thumbnails View: In the Thumbnails View the disk icon is displayed below each 
thumbnail. 
Text List View: In the Text List View the disk icon is displayed to the left of each 
record. 
Info Sheet View: In the Info Sheet View the disk icon is displayed below the 
thumbnail.
Keywords View: In the Keywords View the disk icon is displayed below the 
thumbnail.
Source Image View: In the Source Image View, there is no disk icon. If a file is off-
line, the Source Image View is not able to display the source image. Instead it 
displays the message Picture could not be displayed.

__________
See Also

Check Volumes



File Information

File information is non-modifiable information about the source file. File information is 
automatically entered into a record when a source file is acquired or updated. To display the 
file information for a record, select a record and choose FILE INFO from the Record menu or 
click the file information icon on the toolbar. The FILE INFO command and the file 
information icon on the toolbar are only available if a single record is selected. File 
information can also be displayed by double clicking a disk icon in any view.

Note: Although you cannot modify the file information, you can select and copy the 
information from any individual field.

The File Information dialog provides the following information about the source file:

File Name the name of the source file.

File Type a three letter code that indicates what format the source file has 
been saved as.

File Size the amount of disk space the source file uses.

Image Width the width of the source image in pixels.

Image Height the height of the source image in pixels.

File Modified the date the source file was last modified.

Volume Name the name of the volume on which the source file is located.

File Location the drive, path, and file name where the source file is located.

To close the File Information dialog, click the OK button.

__________
See Also

File Info Commnand
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Creating A New Collection

Collections are the documents created and read by ImageAXS. Each collection is an 
imagebase made up of individual records. ImageAXS allows you to create and maintain as 
many different collections as you like; however, only one collection can be open at a time. 

Important! You should make a back-up copy of each collection, as you should any 
important document, to avoid potential loss of data.

To create a new collection:
1. Select NEW from the File menu. 

2. Designate a name and location for the new collection to be saved.

3. Click the OK button.
A blank collection window opens with the name of the new collection in the title bar 
of the application window. 

You are now ready to set preferences and begin creating records.

__________
See Also

New Command



Setting Preferences

Preferences allow you to customize certain areas of ImageAXS. Preferences may be set any 
time after a collection has been created; however, it is best to set them before any records 
are created.

There are two types of preferences in ImageAXS: collection preferences and system 
preferences. Collection preferences are preferences that are saved specifically with the 
collection that is currently open and apply only to that collection. System preferences are 
preferences that are saved in the Windows directory and apply to any collection you open. 

To modify the Preferences, select PREFERENCES from the Edit menu and select an option 
from the sub-menu that appears:

Assigning Field Labels

Selecting A Thumbnail Label

Modifying System Settings

PhotoCD Options

Monitor Settings

__________
See Also

Preferences Command



Assigning Field Labels

Each record in ImageAXS contains eight user definable fields into which you can enter text. 
The default names for these fields are Field 1 through Field 7 and Description. Fields 1 
through 7 can each contain up to 79 characters and the description field can contain up to 
32,000 characters. 

This preference allows you to change the labels for the eight user definable text fields to 
reflect the information that you will be entering into them. Assigning Field Labels is a 
collection preference.

Field Labels may be changed at any time. Changing the label for a field does not affect the 
data that may already be contained in that field. All changes made to the field labels apply 
to all records in a specific collection. You may not selectively change field labels for 
individual records.

To change the field labels:
1. Select ASSIGN FIELD LABELS from the Preferences sub-menu.

A Field Labels dialog appears. 
2. Highlight the label you want to change and type in a new one. 

Each label is limited to 31 characters. 
3. Click the OK button to save the changes you have made. 

All views that display field labels are automatically updated to reflect the new labels and you
are returned to the view from which you opened the Preferences. 



Selecting A Thumbnail Label

This preference allows you to determine what information is displayed beneath each 
thumbnail in the Thumbnails View, Info Sheet View, and Keywords View. Selecting a 
Thumbnail Label is a collection preference .

To select a thumbnail label:
1. Choose SELECT THUMBNAIL LABEL from the Preferences sub-menu. 

A dialog appears containing all of the fields available for display. 
2. Select the field you want to display by clicking it.

Important! Only approximately the first 15 characters of the field you have chosen
will display if you are viewing large thumbnails. Fewer characters will display if you 
are viewing small thumbnails.

3. Click the OK button. 

This automatically changes the information that is displayed beneath each thumbnail in the 
Thumbnails View, Info Sheet View, and Keywords View, and returns you to the window from 
which you opened the preferences.



Modifying System Settings

The Systems Settings dialog has six different Preference options. All System Settings are 
system preferences. When you have finished making changes to the System Settings, click 
the OK button. 

Thumbnail Type

Thumbnail Cache

Text Cache

Image Spool Threshold

Color Mode

Thumbnail Size

System Font

Double Click On View Creates New Project



Thumbnail Type

When a source file is acquired, a thumbnail is created and entered into a record. A thumbnail
is a small representation (no side larger than 128 pixels) of the full resolution source image 
that was acquired. This option allows you to determine what kind of thumbnails are created. 

There are two options available to you: 24-bit compressed or 24-bit uncompressed. Although
both of these options are 24-bit, you will still be able to view them if you only have an 8-bit 
video card.

24-bit compressed thumbnails take up less disk space (3-5k); however they take longer 
to display (because they must be decompressed when viewed) and the display quality is 
lower than that of uncompressed thumbnails. Compressed thumbnails are saved in a 
collection as .JPG's.

24-bit uncompressed thumbnails take up more disk space (up to 50k), but they display 
more quickly and are higher quality than compressed thumbnails. Uncompressed thumbnails
are saved in a collection as .BMP's.

To change the thumbnail type, select either 24-bit compressed or 24-bit uncompressed from 
the THUMBNAIL TYPE pop-up list.

Important! Changing the Thumbnail Type does not affect the bit depth of the source 
image. Changing the thumbnail type only affects those thumbnails acquired after the 
change is made. To change existing thumbnails you must update or re-acquire them.

Tip: If you are going to be exporting records from ImageAXS for Windows to be imported 
into ImageAXS for Macintosh (or vice versa), the records should contain compressed 
thumbnails. Uncompressed thumbnails will not display after being transferred cross-
platform.

__________
See Also

Cross Platform Importing and Exporting
JPEG
BMP



Thumbnail Cache

The thumbnail cache allows you to set the number of thumbnails that are kept in memory at
one time. This does not mean that you cannot access all of the thumbnails in a collection, it 
simply means that the number you set limits the number of thumbnails in memory at any 
one time.

Thumbnails that are cached can be viewed much more quickly than those that have to be 
read into memory. A large thumbnail cache speeds scrolling through a larger range of 
thumbnails; however, a large thumbnail cache ties up more of your computer's memory.

As you view thumbnails (in the Thumbnails View, the Info Sheet View, or the Keywords View) 
they are kept in memory (cached) until the number you have designated as your maximum 
cache size is reached. When you have reached your maximum cache size and you view 
another thumbnail, that thumbnail is read into memory and the very first thumbnail you 
looked at is removed from memory.

The default setting for the thumbnail cache is 12 thumbnails. This can use from 30k to 600k 
of memory depending on what type of thumbnails you are working with (compressed or 
uncompressed). If you have more memory available, you may want to increase this number. 
To change the thumbnail cache setting, simply type the number of records you want cached 
over the existing number. The current limit for the thumbnail cache is 128.



Text Cache

The text cache sets the number of text records that the computer keeps in memory at any 
one time. This works exactly like the thumbnail cache except that instead of caching 
thumbnails the text cache caches the text from records. 

The default setting for the text cache is 24 records. 24 records can take up a very small or a 
very large amount of memory depending on how much text is contained in each record. If 
you have enough memory available, you may want to increase the number of text records 
that you cache. 

To change the text cache setting, simply type the number of records you want cached over 
the existing number. The current limit for the Text Cache is 256 records.



Image Spool Threshold

When a source image is displayed, it can either be read into your computer's memory in its 
entirety or, if it is too large, it can be spooled. Spooling means the image is read from disk 
and drawn to the screen a little at a time. If the entire image is in memory, display functions 
such as zooming and scrolling are much faster than if the image has to be re-spooled for 
each new display. 

The spool threshold is a limit above which source images are spooled rather than read into 
memory. For example, if you set your spool threshold to 3,000K, images that require more 
memory than that are spooled while smaller images are read into memory in their entirety 
(if there is enough memory available). 

Important! Regardless of the spool threshold you set, the program will not read the 
source image into memory unless it can fit the entire image into half the available system 
memory. 

A larger spool threshold ties up more memory, but allows for fast zooming and scrolling of 
large images. A smaller spool threshold uses less memory, but forces slower redrawing of 
large images.

To change the Spool Threshold, simply type over the existing value. The default threshold is 
2,000 K.



Color Mode

This option allows you to determine the color scheme used on the windows, buttons, text, 
etc. within ImageAXS. There are three choices: Light Grays, Dark Grays, and System Colors. 

The default is Light Grays. The Dark Grays option provides a dark charcoal gray background 
against which to view your images, and System Colors uses the colors you have set up for 
Windows and applies them to ImageAXS. Experiment to find out which color mode works 
best for you. 

To change color modes, simply select the mode of your choice from the pop-up list.



Thumbnail Size

This option allows you to determine what size thumbnails are displayed in the Thumbnails 
View. You can choose between large thumbnails (128 x 128 pixels) or small thumbnails (80 x 
80 pixels).

Small thumbnails allow you to display more thumbnails at a time. Large thumbnails allow 
you to see more details of the images. The Info Sheet View and the Keywords View always 
display large thumbnails.

To select a thumbnail size, select LARGE THUMBNAILS or SMALL THUMBNAILS from the pop-
up list.



Use System Font

This option allows you to determine which font is used for the text in ImageAXS. The default 
font for all text is ImageAXS (except for dialogs and menus) is Arial size 12. If you would 
prefer to use your system font instead, select this option. If the box to the left of this option 
is checked, the option is selected. Click the box to select or deselect this option.



Double Click On View Creates New Project

If this option is selected, you will be able to create new projects by double clicking certain 
items within the active window. For example: if this option is selected and you double click a
thumbnail in the Thumbnails View, the Info Sheet View, or the Keywords View, a new project 
is created. The new project contains the record whose thumbnail you double clicked, and 
that record is displayed in the Source Image View.

If this option is not selected, you can only create projects by using the NEW or ADD TO 
commands from the Project menu, or by double clicking one of the view icons on the toolbar.
For example: if this option is not selected and you double click a thumbnail in the 
Thumbnails View, the Info Sheet View, or the Keywords View, the view in the active window 
simply changes to the Source Image View. No new project is created.

Regardless of whether or not this option is checked, double clicking on a view icon on the 
toolbar opens a new project containing those records that were selected when you double 
clicked (or all of the records in the collection if no records were selected). The records in the 
new project are displayed in the view represented by the icon you double clicked.

The default setting for this option is checked. Select or deselect this option by clicking the 
checkbox.
__________
See Also

Creating Projects
New Command
Add To Command



PhotoCD Options

This preference allows you to choose the color mode and resolution for viewing PCD source 
images. You can set the color mode and resolution for each PCD source image that you want
to view or you can set a default color mode and resolution. This preference is a system 
preference.

To open the PhotoCD Options dialog, select PHOTOCD OPTIONS from the Preferences sub-
menu. The PhotoCD Options dialog appears prompting you to select a color mode and a 
resolution for the image to be viewed.

At the bottom of the dialog is an ALWAYS ASK FOR PHOTOCD OPTIONS checkbox. If this 
checkbox is checked, the PhotoCD options dialog will appear each time you attempt to 
display a PCD source image or copy it to the clipboard. If this option is not checked, the 
settings you select become the default settings for each PCD source image you view or copy
to the clipboard.

Important! Selecting LAB COLOR in the PhotoCD Options dialog as the color 
mode for viewing PCD source images will result in improperly displayed images.



Monitor Settings

These preferences allow you to set the cache size and monitoring frequency for the monitor 
window, determine which types of files are displayed int he monitor window, and set options 
for acquiring images from the monitor window. These preferences are all system 
preferences.

To open the Monitor Settings dialog, select MONITOR SETTINGS from the Preferences sub-
menu.

Cache Size: This setting allows you to set how many files from the directory you are 
monitoring are kept in memory at one time. This setting works exactly like the 
Thumbnail Cache except that it caches images from the directory you are monitoring 
instead of thumbnails from a collection.

To change this setting, simply type over the current number. The default setting is 12 
thumbnails.

Frequency: This setting allows you to set the frequency of the monitoring in the monitor
window. When the monitor window is actively monitoring a directory, it checks that 
directory periodically for changes and if changes have occurred (e.g., files have been 
added or removed) it updates the monitor window to reflect those changes.

The frequency setting determines how often a directory that you are monitoring is 
scanned for changes. To change this setting, simply type over the current number. 
Frequency is measured in seconds and the default setting is 5 seconds.

Filter Non-Image Files: This setting allows you to determine whether the monitor 
window displays all of the files in the directory you have chosen to monitor or just the 
image files. If this option is selected, only image files of supported file types will be 
displayed in the monitor window. If the box to the left of this option is checked, the 
option is selected. Click the box to select or deselect this option.

If you have selected to filter out non-image files, you may experience a slight delay 
between selecting a directory to monitor and the actual appearance of the images in the 
monitor window.

Acquire Options: The monitor window acquire options allow you to determine whether 
or not you want to move source files when you acquire them from the monitor window.

If you want to move source files when you acquire them from the monitor window, check 
the MOVE SOURCE IMAGES TO: checkbox. This activates the two destination options 
located directly beneath the checkbox. You must select one of the options:

Collection Directory - Select this option to move the source files to the directory 
containing the collection into which you are acquiring the files.
Custom Directory - Select this option to move the source files to a directory of your
choice. The current directory is displayed directly beneath the CUSTOM DIRECTORY 
option. To change the directory into which the source files are to be moved, click the 
CHANGE button. A dialog appears prompting you to select a directory. Select a 
directory and click the OK button.

When you are finished with the Monitor Settings, click the OK button to close the dialog and 
implement your settings.



__________
See Also

Moving Source Files as they are Acquired
Monitoring



Creating Records

Each collection you create is made up of individual records. A record contains information 
about a single source file. To create a record, you must select a source file and acquire it. 

When a source file is acquired it is not altered in any way. The program simply "takes a 
snapshot" of the image in the source file and creates a thumbnail version that is then 
entered into a record in your collection.

In addition to creating a thumbnail, the acquire process also records certain file and location 
information about the source file (file information) that is stored, along with the thumbnail, 
in the record. If a source file includes text in the form of a caption, ImageAXS also 
automatically enters that information into the large text field.

ImageAXS supports (i.e. can acquire and create thumbnails for) files of the following file 
types: GIF, EPS, WMF, WPG, PIC, PCT, BMP, DCX, JIF, JPG, PCX, TGA, and TIF. AVI movie files 
and WAV sound files can also be acquired; however, a Sound Recorder icon or a Media Player
icon is displayed instead of a thumbnail. You can view AVI movie files and listen to WAV 
sound files with the Launch Editor command.

If you acquire file of unsupported file types, they appear as 'Unreadable File' thumbnails.

To acquire source files:
1. Select ACQUIRE NEW IMAGES from the Record menu.

The Acquire New Images dialog appears.
2. Select a directory from the Directories box.

All of the image files in the directory you select are shown in the 'File Name' box. PCD
files and non-image files are only shown if you select ALL FILES (*.*) from the 'List 
Files of Type' box.

3. Select the files that you want to acquire by clicking them.
Use the SHIFT and CONTROL keys to select multiple files at a time.

4. Click the ADD button to add the files you have selected to the Acquire Log 
at the bottom of the dialog. 
Files must be added to the Acquire Log in order to be acquired. If you want to add all 
of the files in the File Name box to the Acquire Log, click the ADD ALL button. To add 
a single file from the File Name box to the Acquire Log, double click the file you want 
to add. To remove files from the Acquire Log, select the files you want to remove and 
click the REMOVE button.

5. If you also want to acquire files from another directory, repeat steps 2 
through 4.

6. When the Acquire Log contains all of the files that you want to acquire, 
click the OK button.
This acquires the files you have listed in the Acquire Log and creates a record for 
each one.

__________
See Also

Acquire New Images Command



Supported File Types
Entering Data
Launching An Image Editor



Opening An Existing Collection

To open a collection that already exists (such as the sample collection included with 
ImageAXS):

1. Close any open collections.

2. Select OPEN from the File menu. 
A dialog appears prompting you to select a collection to open. 

3. Locate and select a collection to open.

4. Click OK. 
The collection you have selected opens to the Thumbnails View.

__________
See Also

Open Command
Opening the Sample Collection



Closing A Collection

In order to open another collection, you must first close the collection that is currently open. 

To close a collection:
1. Select CLOSE from the File menu or close the collection window.

Any open projects are closed when the collection is closed. If any of the open projects
have unsaved changes, you are prompted to save them.

__________
See Also

Close Command



Viewing and Editing Collection Information

The Collection Information dialog is available so that you can enter general information 
about an entire collection. The Collection Information dialog is resizable for ease of viewing.

To open the Collection Information dialog, select COLLECTION INFO from the File menu.

You may enter text (up to 32,000 characters) or edit text that has already been entered. 

To save changes you have made to the Collection Information, click the OK button.

__________
See Also

Collection Info Command
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Creating A New Project

Adding Records to a Project

Removing Records from a Project

Saving A Project

Opening an Existing Project

Closing A Project



Creating A New Project

To create a new project, select NEW from the Project menu. An empty project window 
appears on your screen. Either minimize the project window or use the TILE feature from the 
Window menu so that you can view the collection window and the project window at the 
same time.

When you create a project it is automatically associated with the current collection. You can 
only add records to the project from the current collection, and you can only open a project if
its associated collection is open.

This is only the most basic way to create a project. Depending on how you have set your 
preferences, projects can be created by double clicking view icons on the toolbar and/or 
certain items within a collection window or project window. For more information about how 
to create a project, see Creating Projects.

__________
See Also

New Project Command



Opening An Existing Project

You can only open projects that are associated with the collection that is currently open. If 
you attempt to open a project that is associated with a collection other than the current 
collection, an error message appears.

To open an existing project:
1. Select OPEN from the Project menu. 

A dialog appears prompting you to choose a project to open. 
2. Select a project.

3. Click the OK button.
__________
See Also

Open Project Command



Adding Records to a Project

Records can be added to a project from the Windows File Manager, a collection window, or 
another project window. A project cannot contain records from more than one collection. 
Adding a record to a project does not remove it from the collection or project it came from. 

There are several ways to add records to a project: 

1. Select the record(s) that you want to add to the project and choose ADD TO
from the Project menu. 
A dialog appears prompting you to select the project to which you want to add the 
records. The dialog lists those projects that are currently open as well as the option to
create a new project (<New Project>).
Select a project from the dialog and click the OK button.

2. Select the record(s) that you want to add to a project and drag & drop them
directly onto an open project window or a project icon.
This can be done from the File Manager or any view except the Source Image View.

3. Use the ACQUIRE NEW IMAGES command to create records directly in an 
open project.
The project must be the active window in order for this method to work. Any records 
added to a project window by this method are also added to the collection window.

__________
See Also

Creating Records
Add To Command
Removing Records from a Project



Removing Records from a Project

Removing a record from a project removes it from that specific project only and has no effect
on the collection window or any other project windows. However, if a record is removed from
a collection, it is automatically removed from any and all projects in which it has been 
placed.

To remove records from a project:
1. Select the record(s) that you want to remove from the project.

2. Choose REMOVE from the Project menu. 
A warning appears asking if you really want to remove the selected records from the 
project.

3. Click the OK button.

From the Thumbnails View or the Text List View you can select the records that you want to 
remove and press the DELETE key. The drag & drop option is not available for removing 
records from a project.

__________
See Also

Remove Command Project
Adding Records to a Project



Saving A Project

Any project that you want to use at a later date must be saved. If you attempt to close a 
project with unsaved changes, a dialog appears prompting you to save it. 

If you have not made any changes to the project since it was created, you will not be 
prompted to save the project and the project will be lost if you do not save it.

To save a new project:
1. Select SAVE from the Project menu. 

A dialog appears prompting you to designate a name and location for the project. 
2. Designate a name and location for the project.

3. Click the OK button.

Important! The Save icon on the toolbar only saves changes made to individual records. It
cannot be used to save projects.

If you have already saved a project and you want to save it under a different name, select 
SAVE AS from the Project menu.

You can also use the SAVE AS feature to save an entire collection as a project. 

To save an entire collection as a project:
1. Make sure that the collection window is the active window.

2. Select SAVE AS from the Project menu.
The Save As dialog appears.

3. Designate a name and location for the project.

4.  Click the OK button.

Note: Project files are very small even if you have saved your entire collection as a project 
(a 200 record project is approximately 1k.) This is because the project does not contain the 
actual records, but pointers to the records in the collection with which it is associated.

__________
See Also

Save Command Project
Save As Command



Closing A Project

To Close a project:

1. Make sure that the project window is the active window.

2. Select CLOSE from the Project menu. 

If you close a collection, all open projects associated with that collection close as well.

If you attempt to close a project with unsaved changes, a dialog appears prompting you to 
save it. 

Important! If you have not made any changes to the project since it was created, you will 
not be prompted to save the project and the project will be lost if you do not save it.

__________
See Also

Close Command Project



Viewing Records

ImageAXS provides many different ways to look at the records in your collections and 
projects. These are called views. When you switch from one view to another, the records in 
the active window do not change; all that changes is the way in which those records are 
displayed. Each window is independent when it comes to views; switching the view in one 
window has no effect on the other open windows.

There are five different views in ImageAXS: Thumbnails View, Text List View, Info Sheet View,
Keywords View, and Source Image View. The Thumbnails View and Text List View display 
multiple records at a time and the Info Sheet View, Keywords View, and Source Image View 
display one record at a time. 

Thumbnails View

Text List View

Info Sheet View

Keywords View

Source Image View

SlideShow

Fit Window to View



 Thumbnails View

The Thumbnails View displays the thumbnails in the collection or project in the active 
window. When you open a collection in ImageAXS, it automatically opens to the Thumbnails 
View. The Thumbnails View is also the default view for projects created using the NEW 
command under the Project menu.

To switch the viewing mode of the active window to the Thumbnails View, select 
THUMBNAILS from the View menu or click the Thumbnails View icon located on the toolbar.

The Thumbnails View displays as many thumbnails at one time as will fit in the active 
window. Thumbnails can be viewed as either large thumbnails (128 x 128 pixels) or small 
thumbnails (80 x 80 pixels). Resizing the window and/or changing the type of thumbnails 
you are viewing (large or small) increases or decreases the number of thumbnails you can 
view simultaneously. The total number of records in the collection, the number of records 
available for viewing in the active window, and your current position in the active window 
are all displayed in the status bar located at the bottom of the application window.
__________
See Also

Navigating
Configuring the Thumbnails View
Thumbnails Command
Thumbnail Size



Navigating

To move through the thumbnails a row at a time, use the scroll bar on the right hand side of 
the window or the up and down arrows on your keyboard.

To move through the thumbnails a window at a time, use the FIRST, PREVIOUS, NEXT, and 
LAST commands under the Browse menu, the navigation icons located on the toolbar, or the
HOME, PAGE UP, PAGE DOWN, and END buttons on your keyboard. 

To switch to another view, select an option from the View menu or click the appropriate icon 
on the toolbar.



 Text List View

The Text List View is a text-only list that displays the text data from the collection or project. 
The information is displayed in rows and columns; one row for each record and one column 
for each data field. To switch to the Text List View from another view, select TEXT LIST from 
the View menu or click the Text List View icon located on the toolbar.

The Text List View displays as many rows as fit into the window vertically and as many 
columns as fit horizontally. It is possible to increase or decrease the number of columns and 
rows that can be viewed by resizing the window. The total number of records in the 
collection, the number of records available for viewing in the active window, and your 
current position in the active window are all displayed in the status bar located at the 
bottom of the application window.
__________
See Also

Navigating
Configuring the Text List View
Text List Command



Navigating

To move through the text data in the Text List View a row at a time, use the scroll bar on the 
right hand side of the Text List window. To move through the text data in the Text List View a 
column at a time, use the scroll bar at the bottom of the Text List window.

To move through the text data in the Text List View a window at a time, use the FIRST, 
PREVIOUS, NEXT, and LAST commands under the Browse menu, the navigation icons located
on the toolbar, or the HOME, PAGE UP, PAGE DOWN, and END keys on your keyboard. 

To switch to another view, select an option from the View menu or click the appropriate icon 
on the toolbar.



Configuring the Text List View

The Text List View allows the user to determine which data field is displayed in each column.

To select the data to be displayed in a particular column:
1. Click the field label at the top of the column you want to configure.

2. Select a field from the list that appears.

The corresponding data is then displayed in that column.

__________
See Also

Text List View



 Info Sheet View

The Info Sheet View displays the thumbnail, text information, and keywords for each record 
and is the main data entry interface for ImageAXS. 

To switch to the Info Sheet View, select INFO SHEET from the View menu or click the Info 
Sheet View icon on the toolbar.

The Info Sheet View displays each image record individually. Each record is displayed with: a 
large thumbnail, a disk icon, keywords, the date the file was acquired, and eight user 
definable data fields. The large text field at the bottom of the window is a scrollable field. 
Use the scroll bar located on the right side of the field to move through the information. For 
ease of viewing you may resize the Info Sheet window.

Keep in mind that although only one record at a time can be seen, all of the records in the 
collection or project are available to be viewed. The total number of records in the collection,
the number of records available for viewing in the active window, and your current position 
in the active window are all displayed in the status bar located at the bottom of the 
application window.
__________
See Also

Navigating

Entering Data

Saving A Record

Info Sheet Command



Navigating

To move through the records in the Info Sheet View, use the FIRST, PREVIOUS, NEXT, and 
LAST commands under the Browse menu, or the navigation icons located on the toolbar.

To switch to another view, select an option from the View menu or click the appropriate icon 
on the toolbar.



Entering Data

The Info Sheet View is the only place within ImageAXS where you can enter data into the 
eight user definable data fields. To enter data into a field, simply place the cursor in that 
field and type. To move to another field, click in the desired field or use the TAB key to move 
through the fields. Fields 1 through 7 can each contain up to 79 characters, and the 
description field at the bottom of the info sheet can contain up to 32,000 characters.
__________
See Also

Info Sheet View
Saving A Record
Save Command



Entering Data
You can enter data into records one at a time from the Info Sheet View or the Keywords 
View.
Text data can be entered into multiple records simultaneously via the Copy Record and 
Paste Record features.
Keywords can also be attached to multiple records at once via the Keywords Dialog.

__________
See Also

Info Sheet View
Keywords View
Copying and Pasting Records
Keywords Dialog



 Saving A Record

Any changes you make to a record in the Info Sheet View are automatically saved when you 
switch views or move on to another record within the Info Sheet View. If, however, you want 
to save the changes you have made before moving on, select SAVE from the Record menu or
click the Save icon on the toolbar. 

If you have made changes to a record that you do not want saved, select REVERT from the 
Record menu before switching views or moving on to another record. This returns the record 
to the state of its last save.

Important! Moving from record to record automatically saves any changes you have 
made. If you do not want to save the changes you have made, you must use the REVERT 
command before moving on to the next record.
__________
See Also

Info Sheet View
Save Command
Revert Command



 Keywords View

The Keywords View displays the thumbnail and keywords from each record. Keywords are 
descriptive words that you can include in a record to facilitate searching. Keywords are most 
commonly used to describe the image associated with a record.

To switch to the Keywords View, select KEYWORDS from the View menu or click the Keywords
View icon on the toolbar. 

The Keywords View displays each image record individually. Each record is displayed with: a 
large thumbnail, a disk icon, the Master Keyword List, and the Keyword List (for the current 
record). For ease of viewing you can resize the Keywords window.

Remember that although only one record at a time can be seen, all of the records currently 
in the collection or project are available to be viewed. The total number of records in the 
collection, the number of records available for viewing in the active window, and your 
current position in the active window are all displayed in the status bar located at the 
bottom of the application window.

From the Keywords View you can edit keywords in the Master Keyword List as well as attach 
keywords to and detach them from the current record. The Master Keyword List contains all 
of the keywords in the collection. A keyword must be in the Master Keyword List before you 
can attach it to a record.

You can only attach keywords to one record at a time in the Keywords View. Use the 
Keywords Dialog to apply keywords to multiple records at a time.
__________
See Also

Navigating

Adding Keywords to the Master Keyword List

Removing Keywords from the Master Keyword List

Modifying Keywords in the Master Keyword List

Attaching Keywords to a Record

Removing Keywords from a Record

Keywords Dialog
Keywords Command



Navigating

To move through the records in the Keywords View, use the FIRST, PREVIOUS, NEXT, and 
LAST commands under the Browse menu or the navigation icons located on the toolbar. 

To switch to another view, select an option from the View menu or click the appropriate icon 
on the toolbar.



Adding Keywords to the Master Keyword List

The Master Keyword List is a list of keywords from which you can select keywords to add to 
the current records. A keyword must be on the Master Keyword List before it can be attached
to a record; however, adding keywords to the Master Keyword List does not automatically 
attach them to the current record.

To add a keyword to the Master Keyword List:
1. Click in the data entry field located directly above the Master Keyword List.

2. Type in a keyword.

3. Click the CREATE button or press ENTER.
The keyword is added to the Master Keyword List.

__________
See Also

Removing Keywords from the Master Keyword List

Modifying Keywords in the Master Keyword List

Keywords View
Keywords Dialog



Removing Keywords from the Master Keyword List

Removing a keyword from the Master Keyword List also removes it from any records to which
it has been attached.

To remove keywords from the Master Keyword List:
1. Highlight the keyword(s) in the Master Keyword List that you want to 

remove.

2. Click the DELETE button.

__________
See Also

Adding Keywords to the Master Keyword List

Modifying Keywords in the Master Keyword List

Keywords View
Keywords Dialog



Modifying Keywords in the Master Keyword List

Modifying a keyword in the Master Keyword List also modifies it in any record to which it has 
been attached.

To modify keywords that have already been added to the Master Keyword List:
1. Click the keyword that you want to modify.

The Modify Keyword dialog appears.
2. Type in the modified keyword.

3.  Click the OK button.

__________
See Also

Adding Keywords to the Master Keyword List

Removing Keywords from the Master Keyword List

Keywords View
Keywords Dialog



Attaching Keywords to a Record

Once you have added keywords to the Master Keyword List, they can be added to individual 
records.

To attach keywords to a record:
1. Select the keyword(s) in the Master Keyword List that you want to attach to

the current record.

2. Click the ATTACH button.

Double clicking a keyword in the Master Keyword List also attaches it to the current record.

__________
See Also

Removing Keywords from a Record

Keywords View
Keywords Dialog



Removing Keywords from a Record

Removing keywords from a record removes them from that record only.

To remove keywords from a record:
1. Highlight the keyword(s) in the Keyword List that you want to remove.

2. Click the DETACH button.

__________
See Also

Attaching Keywords to a Record

Keywords View
Keywords Dialog



 Source Image View

The Source Image View displays the source image for each record. The source image is the 
full size image from which the thumbnail was created. 

To switch to the Source Image View, select SOURCE IMAGE from the View menu or click the 
Source Image View icon located on the toolbar.

Whenever possible source images are displayed at a 1:1 ratio (100%). If the image will not 
completely fit into the window at 1:1, it is initially displayed at 1:2 (50%) or 1:4 (25%). The 
size at which the image is currently displayed is shown after the file name in the title bar of 
the window, e.g., [Collection: All Records - bigtree.jpg (1:2)]. Use the Zoom In and Zoom Out 
features to display the source image at different sizes.

Keep in mind that although only one source image at a time can be seen, all of the records 
in the collection or project are available to be viewed. The total number of records in the 
collection, the number of records available for viewing in the active window, and your 
current position in the active window are all displayed in the status bar located at the 
bottom of the application window.
__________
See Also

Navigating
Zooming In and Out
Automatic Scaling
Source Image Command



Navigating

To move back and forth through the images in the Source Image View, use the FIRST, 
PREVIOUS, NEXT, and LAST commands under the Browse menu, or the navigation icons 
located the toolbar.

To switch to another view, select an option from the View menu or click the appropriate icon 
on the toolbar.



Zooming In and Out

The Source Image View initially displays each image as close to 100% of its original size as 
possible while still displaying the entire image in the window. You can change the ratio at 
which the source image is displayed by zooming in or out on the image. 

When you move the cursor over the source image in the Source Image View, the cursor 
becomes a magnifying glass with a + at its center. Clicking the mouse while the magnifying 
glass is positioned over the full image, zooms in on the image at the point at which the 
magnifying glass is positioned. Holding down the SHIFT key changes the + at the center of 
the magnifying glass to a -, and clicking the mouse then zooms out. It is possible to zoom up
to 16 times larger or 16 times smaller than the actual size of the source image.

Zooming does not affect the source image; it only changes the scale at which it is displayed.
The scale at which the image is currently displayed is given after the file name in the title 
bar.

Depending on the size of your monitor, an image may open smaller than 1:1 (full size). To 
view that image at 1:1, place the magnifying glass cursor over the image and click until the 
image is shown at the desired size. For example, to view a 1:4 (25% of actual size) image at 
1:1, place the magnifying glass cursor at the center of the image and click twice. The image 
is now larger than the window. In order to see more of the image, make sure that the 
window is maximized. Use the scroll bars located on the bottom and the right hand side of 
the screen to view parts of the image that do not fit in the window.

Another way to zoom in or out on an image is to use the ZOOM IN and ZOOM OUT 
commands from the View menu.

__________
See Also

Source Image View
Automatic Scaling
Zoom In Command
Zoom Out Command



Automatic Scaling

You can set ImageAXS to automatically scale the source image to the size of the window it is
in. To do this, select SCALE IMAGE TO WINDOW from the View menu. 

If automatic scaling is on and you change the size of the window, ImageAXS automatically 
calculates the largest size at which the image will fit into the new window size while still 
retaining its original proportions. The image is then displayed accordingly. Images are never 
scaled to a size larger than 100% of the source image (1:1) no matter how large you make 
the window.

Automatic scaling must be turned on or off; once you turn it on, it remains on for that 
specific window until you turn it off or switch to another view. To turn automatic scaling off, 
simply select SCALE IMAGE TO WINDOW from the View menu again. A checkmark next to the
SCALE IMAGE TO VIEW command indicates that automatic scaling is on.

__________
See Also

Source Image View
Zooming In and Out



SlideShow

The SlideShow is not a view, but a way to display records within a view. The SlideShow 
displays the records in a collection or project by cycling through them a window at a time (in
the Source Image View, Info Sheet View, and Keywords View this means one record at a 
time). When you run a SlideShow, the record or set of records (depending on the view) in the
active window is displayed for a set amount of time and is then replaced by the next record 
or set of records. The SlideShow is most commonly used to cycle through the images in the 
Source Image View.

To start a SlideShow: 
1. Select SLIDESHOW from the Browse menu.

The SlideShow dialog appears.
2. Set the amount of time you want each window to be displayed by typing a 

number in the Interval field.
The interval is given in seconds. The default interval is 3 seconds. The interval time 
does not begin until the current window has finished drawing.

3. Select whether the SlideShow is to run forwards or backwards by clicking 
the option of your choice.

4. If you want the SlideShow to run continuously, click the CONTINUOUS LOOP 
checkbox.
If you do not choose to have the SlideShow run in a continuous loop it will stop when 
it reaches the end (or the beginning if you are running it backwards) of the records in 
the active window.

5. Click the OK button.
This starts the SlideShow. If you have chosen to run the SlideShow in a continuous 
loop, it will run until you stop it by selecting STOP SLIDESHOW from the Browse menu
or pressing the ESCAPE key.

You can switch Views in the middle of a SlideShow. Simply click the appropriate icon on the 
toolbar or select the appropriate option from the View menu.

__________
See Also

Views
SlideShow Command



Fit Window to View

Depending on the size of the collection window or project window, the current view may not 
fill the entire window. To resize the window to fit the view, select FIT WINDOW TO VIEW from 
the View window. 

The FIT WINDOW TO VIEW command is only available when the window is not maximized.

__________
See Also

Views
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Selecting Records

Often when you are working with a collection or a project you want to single out certain 
records or groups of records (i.e., make a selection). This can be done from the Text List View
or the Thumbnails View. 

Remember that the Info Sheet View, Keywords View, and Source Image View are single 
image views that display one record at a time. Therefore you are always working with a 
selection of one and it is not possible to select multiple records or make batch changes of 
any kind from those views. 

The record or records that are to be included in your selection must be identified. To select a 
single record, click a thumbnail in the Thumbnails View or a text line in the Text List View. 
Selected records become highlighted. 

You can select records individually, as described above, or you can select groups of records. 
There are three ways to select groups of records:

1) To select a group of consecutive records, click a record and hold down the SHIFT key 
as you click a second record. This highlights the records that you clicked as well as all
of the records in-between. 

2) To select a group of non-consecutive records, hold down the CONTROL key as you 
click each record you want included in your selection. 

3) To select several disconnected groups of records, combine the two methods listed 
above. For instance if you are in the Thumbnails View and are viewing a 2x4 grid of 
thumbnails and you want to select #2 and #5-#7. Hold down the CONTROL key as 
you select #2 and #5 and hold down both the SHIFT and the CONTROL keys as you 
select #7. 

Other selection options:

- To deselect an individual record, hold down the CONTROL key while clicking it. 

- To deselect all selected records, choose CLEAR SELECTION from the Edit menu.

- To select all of the records in a collection, choose SELECT ALL from the Edit menu. 

- To reduce the contents of the active window to just those records in your selection, 
choose SHOW SELECTION from the Browse menu.

- To invert a selection (i.e., select all those records that are not selected and deselect 
all those records that are selected), choose INVERT SELECTION from the Edit menu.

__________
See Also

Views
Select All Command
Show Selection Command
Invert Selection Command



 Creating Blank Records

ImageAXS allows you to create blank records (i.e., records that are not associated with a 
source file). You may want to create blank records in order to enter data before the 
corresponding images are available.

To create a blank record, select NEW from the Record menu or click the New icon on the 
toolbar. This creates a new record in the active window. A 'no thumbnail' image is displayed 
in place of a thumbnail for the new record until a source file is acquired.

When you are ready to acquire a source file, use the Update feature to do so.

Important! Source files will have to be acquired into blank records one at a time.
__________
See Also

New Command
Update Command



Copying and Pasting Records

Often data is the same from record to record within a collection. Instead of having to enter 
the same data time after time, you can use the Copy Record and Paste Record features to 
copy data from one record and paste it into other records.
__________
See Also

Copying Data from a Record

Pasting Data into a Record



Copying Data from a Record

The Copy Record feature copies the keywords and all of the text from the eight user 
definable data fields to the Clipboard. The Copy Record feature does not copy the thumbnail 
or the file information.

To copy data from a record to the Clipboard:
1. Select a single record from which you want to copy data.

If you are copying a record from the Info Sheet View, the Keywords View, or the 
Source Image View, the data that is copied is from the record you are viewing when 
you select COPY RECORD. 

2. Select COPY from the Edit menu.

3. Select RECORD from the sub-menu that appears.

Note: When you copy a record, the data is placed as text in the Clipboard and can be 
pasted into other applications as well as into other records.

__________
See Also

Copy Record Command
Pasting Data into a Record



Pasting Data into a Record

After you have copied data from a record, you may paste the data unchanged into another 
record or group of records with the Paste Record feature.

To paste data into a record:
1. Select the record(s) you want to paste into.

If you are pasting data into records in the Info Sheet View, the Keywords View, or the 
Source Image View, you can only paste into one record at a time.

2. Select PASTE from the Edit menu. 

3. Select RECORD from the sub-menu that appears.

This pastes the data that you have copied to the Clipboard into the records in your selection,
overwriting any existing data. You may paste the same information into as many records as 
you want. 

Important! If there are blank fields in the record that you copied to the clipboard, they will
be pasted over fields containing information. Existing Keywords will not be overwritten.
__________
See Also

Paste Record Command

Copying Data from a Record



Copying Source Files

At some point you may want to copy source files to another location on your drive, to 
another machine on your network, or to different media (floppy disk or Syquest cartridge for 
instance). This can be done from within ImageAXS. 

To copy source files:
1. Select the record(s) whose source files you want to copy.

2. Choose COPY SOURCE FILES from the Record menu. 
A Copy Source Files dialog appears with the source files for the records you chose 
listed in the box labeled Source Files.

3. Specify where you want the source files copied in the section labeled 
Destination.
If you want to copy to a destination other than the one listed, type in the destination 
of your choice or click the CHANGE button and select a destination.

4. [optional] Click the CHANGE DATABASE REFERENCES checkbox located in 
the Options section.
Each record in a collection is referenced to its source file. When you copy source files 
you may want to change the references so that they refer to the copies of the source 
files instead of the original source files. 

5. Click the COPY button.

Off-line files cannot be copied. If one of the files that you are attempting to copy is off-line, 
the copy process stops and a dialog appears telling you that the file is off-line and asking if 
you want to continue. Clicking the YES button skips the off-line file and continues copying 
the rest of the selection. Clicking the NO button stops the copy process and returns you to 
the view from which you started.

__________
See Also

Moving Source Files
Copying Images to the Clipboard
Copy Source Files Command



Moving Source Files

At some point you may want to move source files from one place to another on your hard 
drive or the network. This can be done from within ImageAXS. 

Moving is different from copying. Instead of creating copies of the selected source files and 
placing the copies in the designated location, the move feature removes the source files 
from the original location and places them in the designated location.

Moving source files should always be done from inside ImageAXS. If you move files from the 
file manager, ImageAXS no longer knows how to locate those files and they become off-line.

To move source files:
1. Select the record(s) whose source files you want to move.

2. Choose MOVE SOURCE FILES from the Record menu. 
A Move Source Files dialog appears with the source files for the records you chose 
listed in the box labeled Source Files.

3. Specify where you want the source files moved in the section labeled 
Destination.
If you want to move the files to a destination other than the one listed, type in the 
destination of your choice or click the CHANGE button and select a new destination.

4. Click the MOVE button.

Off-line files cannot be moved. If one of the files that you are attempting to move is off-line, 
the move process stops when it reaches it and a dialog appears telling you that the file is 
off-line and asking if you want to continue. Clicking the YES button skips the off-line file and 
continues moving the rest of the selection. Clicking the NO button stops the move process 
and returns you to the view from which you started.

__________
See Also

Copying Source Files
Copying Images to the Clipboard



Removing Records From A Collection

Just as you can add records to a collection, you can also remove them from a collection. 
Removing a record from a collection does not delete the source file; however, removing a 
record from a collection does remove it from any projects you have placed it in.

To remove records from a collection:
1. Select the record(s) that you want to remove.

2. Select REMOVE from the Record menu. 
A warning appears informing you how many records are selected and asking if you 
really want to remove all of them. 

3. Click the OK button to remove the selected records.

From the Thumbnails View and the Text List View you can select records and press the 
DELETE key to remove them.

__________
See Also

Remove Command
Deleting Source Files



Deleting Source Files

When you remove records from a collection you may also want to delete the source files for 
those records. You can remove records from a collection and delete the source files for those
records from within ImageAXS. If you delete the source file for a record that you are not 
removing from the collection, that record becomes off-line.

To delete source files:
1. Select the records whose source files you want to delete.

The records in your selection must be on-line in order for their source files to be 
deleted.

2. Select DELETE SOURCE FILES from the Record menu. 
A warning appears informing you of the number of source files that will be deleted 
and asking if you want to continue. 

3. Click the YES button to delete the source files. 
Click the NO button to return to the view from which you started.
If you click the YES button the source files are deleted and another dialog appears 
asking if you want to remove the records that were associated with those source files.

4. [optional] To remove the records, click the OK button.

__________
See Also

Delete Source Files Command
Removing Records from a Collection



Updating Records

A source file becomes off-line if it has been moved or renamed outside of ImageAXS. The 
Update feature can be used to update a record and bring the source file back on-line. The 
Update feature can also be used to generate a new thumbnail for a record by acquiring a 
different source file or re-acquiring the same source file if it has changed since it was first 
acquired.

The Update feature is available for updating individual records or multiple records.
__________
See Also

Updating A Single Record
Updating Multiple Records
Update Command



Updating A Single Record

To update a single record:
1. Highlight the record you want to update.

2. Select UPDATE from the Record menu. 
The Update dialog appears. 

3. If you want to generate a new thumbnail for the record you are updating, 
make sure that the THUMBNAIL checkbox is checked.
If you are only updating file and location information and do not want to generate a 
new thumbnail, make sure that the Thumbnail checkbox is unchecked. Creating new 
thumbnails slows down the update process considerably.

4. Locate and select the source file that you want to use to update the record.

5. Click the OK button. 
If the record was off-line it is now on-line.

__________
See Also

Updating Multiple Records
Update Command



Updating Multiple Records

To update multiple records:
1. Highlight the records you want to update.

2. Select UPDATE from the Record menu.
The Update dialog appears.

3. Set your update options:
Update All - If this checkbox is checked, all of the records in your selection for which 
ImageAXS can locate a source file in the directory you designate, are updated 
automatically. If this checkbox is unchecked, the update process will ask the location 
of each individual file.
Thumbnail - If you want to create a new thumbnail for each record that is updated, 
make sure that this checkbox is checked. Creating a new thumbnail for each record 
slows down the update process considerably.

4. Locate and select the source file for the first record in your selection.

5. Click the OK button.

If you have selected the Update All option, ImageAXS automatically updates each of the 
records in your selection. The progress of the update is shown in the status bar. 

If, during the update, ImageAXS comes to a record whose source file it cannot locate in the 
same directory as the first source file, the Update dialog re-appears and you are prompted to
locate a source file for that record. If you are unable to or do not want to locate the source 
file, click the SKIP button. Clicking the SKIP button skips the current record and continues on 
with the update until it finishes or comes to another source file that it cannot locate.

The SKIP button is only available if you are updating more than one record.

__________
See Also

Updating A Single Record
Update Command



Renaming A Source File

The name of a source file can be changed from within ImageAXS. Changing the file name 
from within ImageAXS ensures that the source file remains on-line. If you change the name 
from the File Manager, the source file becomes off-line.

Important! A source file must be on-line in order for it to be renamed.

To change a source file name:
1. Highlight the record that corresponds to the source file whose name you 

want to change.

2. Select RENAME from the Record menu. 
The Rename dialog appears. 

3. Type the new file name into the 'File Name' box.

4. Click the OK button. 

This changes the source file name and updates the record to reflect that change.



Importing and Exporting Records

Importing and exporting are ways of sharing information between collections. If you want to 
include some records in more than one collection, the import and export commands allow 
you to do this without having to re-enter data. Sharing information between collections is 
even possible if one collection is in ImageAXS for Windows and the other collection is in 
ImageAXS for Macintosh.

To share records between collections you must first export them. Exporting creates a file that
contains the records you chose to export. This export file (file type .axs) can then be 
imported into another collection.

Currently, records exported by ImageAXS can only be read and imported by ImageAXS, and 
ImageAXS can only import records that have been exported by ImageAXS.
Tip: Importing and exporting is a good way to back up your collections. Simply make a 
backup collection by exporting the entire contents of a collection and importing them into a 
new collection you have created.
__________
See Also

Exporting Records

Importing Records

Cross Platform Importing and Exporting



Cross Platform Importing and Exporting

The Import and Export features in ImageAXS allow you to share information across 
platforms. Records exported by ImageAXS Windows can be imported by ImageAXS 
Macintosh and vice versa.

When transferring ImageAXS records across platforms please keep the following items in 
mind:

- Records to be transferred across platforms should contain compressed thumbnails. 
Uncompressed thumbnails will not display after cross platform transfer.

- The file names of source files that are copied or moved from the Macintosh to the PC 
will be truncated to 8 characters. This will cause any imported records referring to 
them to be off-line and will make updating difficult because the truncated names are 
not Windows format names. We suggest that you change the Macintosh file names to
Windows format (eight characters plus a three character extension, e.g., filetest.tif) 
before you export the records or move the source files.

- When importing records that have been exported from ImageAXS for Macintosh, into 
ImageAXS for Windows, the Macintosh extended character set is converted to the 
Windows standard character set and all text is adjusted accordingly.

- Source files for records that are going to be transferred across platforms should be 
saved on a drive that is available to both platforms and should be saved as file types 
that can be read by both platforms. Currently those file types are: JPG (JPEG), TIF 
(TIFF), and PCT or PIC (PICT).

__________
See Also

Importing and Exporting Records

Modifying System Settings



Exporting Records

Exporting does not remove records from the collection from which you are exporting; it 
simply creates an export file and copies the information to it.

The following information is exported for each record you select to export:
Thumbnail

Eight user definable fields
Keywords

File information
Collection information

To export records from a collection:
1. Select the records that you want to export. 

2. Choose EXPORT from the File menu. 
A dialog appears prompting you to designate a name and location for the export file. 

3. Give the file a name and designate a location for it to be saved.

4. Click the OK button. 

The information from the records you selected is exported and placed in an export file. 

Important! Exporting records from a collection does not remove the records from the 
collection; it just copies the information.
__________
See Also

Importing Records
Cross Platform Importing and Exporting
Export Command



Importing Records

Currently, the only records that can be imported into ImageAXS are those that have been 
exported from ImageAXS for Windows or ImageAXS for Macintosh.

To import records:
1. Select IMPORT from the File menu. 

A dialog appears prompting you to select a file to import. 
2. Select a file to import and click the OK button.

This opens the Import Mapper.
__________
See Also

Exporting Records
Cross Platform Importing and Exporting
Import Command



Import Mapper

The Import Mapper appears immediately after you select an export file to import using the 
Import Command. The Import Mapper allows you to import the correct information into the
correct fields. Suppose that in the collection from which you exported the records the fields 
were ordered: country, city, state, province; but in the collection into which you are 
importing the fields are ordered: country, state, county, city. The Import Mapper allows you 
to ensure that the correct information is placed in the correct fields.

If all of your fields correspond exactly, simply click the LINEAR MAP button. This places all of 
the field labels, paired just as they are, in the Mapping box located at the bottom of the 
window. Click the OK button to import the files.

If your fields do not all correspond exactly, click the NAME MAP button. ImageAXS 
automatically matches up those field labels whose names correspond exactly, and places 
them in the Mapping box. Those labels that do not match remain in the Import Fields and 
Database Fields boxes at the top of the window. To pair the remaining field labels, click on a 
label in the Import Fields box and then double click on the corresponding label in the 
Database Fields box that contains the corresponding information. These labels are then 
paired and placed in the Mapping box. Any fields left unmapped will not be imported.

If you make a mistake, highlight the incorrect pair of labels in the Mapping box and click the 
REMOVE MAP button. This replaces the labels in their correct boxes at the top of the window.

Once you have mapped your labels in the mapping box, you must decide whether or not you
want to import collection information. Each export file is contains the collection information 
from the collection from which the records were exported. If you check the Col. Info 
checkbox, located directly beneath the REMOVE MAP button in the Import Mapper dialog, the
collection information from the imported records will replace the collection information in the
collection into which you are importing. If you do not want to replace the collection 
information, make sure that the Col Info checkbox remains unchecked.

When you are finished, click the OK button. The records are then imported, according to your
set-up in the Mapping box, and added to the current collection.
__________
See Also

Importing Records

Cross Platform Importing and Exporting

Import Command



Navigating to a Specific Record

To navigate to a specific record within a collection:
1. Select GO TO from the Browse menu.

The Go To dialog appears.
2. Type in the number of the specific record you want to move to.

3. Click the OK button.

The view you are using switches to display the record you specified. If you are using the 
Thumbnails View or the Text List View, the view switches to show you a window of records 
that contains the record you specified.

If you have chosen a number that is not valid (e.g., your project has 36 records and you type
in 56), a dialog appears informing you that you must choose another number.

__________
See Also

Go To Command



Copying Images to the Clipboard

ImageAXS allows you to copy source images to the Clipboard to be pasted into other 
applications. You can only copy one source image to the clipboard at a time. Copying an 
image to the clipboard replaces any image or text already in the clipboard.

To copy an image to the Clipboard:
1. Select the record that corresponds to the source image you want to copy.

If you are in the Info Sheet View, Keywords View, or Source Image View, you can only 
copy the source image for the record you are currently viewing.

2. Select COPY from the Edit menu.

3. Select SOURCE IMAGE from the sub-menu that appears.

__________
See Also

Copy Source Image Command



Creating and Using Keywords

Keywords are descriptive words that you can include in a record to facilitate searching. 
Keywords are most commonly used to describe the image associated with a record. The 
Keywords View allows you to view the keywords for each record, edit the Master Keyword 
List, and add keywords to one record at a time. In addition to the Keywords View ImageAXS 
includes a Keywords Dialog for working with multiple records at a time, and a Keywords 
Search.
__________
See Also

Keywords Dialog

Keywords View

Keyword Search



 Keywords Dialog

The Keywords Dialog allows you to work with the keywords for multiple records at once.

To open the Keywords Dialog:
1. Select the record(s) with which you want to work.

If you have opened the Keywords Dialog from the Info Sheet View, the Keywords 
View, or the Source Image View, you can only work with the record you are currently 
viewing.

2. Select KEYWORDS from the Edit menu or click the Keywords icon on the 
toolbar.
The Keywords Dialog appears. The number of records in the current selection is given
in the title bar.

There are two basic components of the Keywords dialog: The Master Keyword List and the 
Working List. The Master Keyword List contains all of the keywords in the collection. A 
keyword must be on the Master Keyword List before you can attach it to a record.

The Working List acts as an intermediate holding place where you place those keywords that
you want to attach to or detach from the records in your selection. Adding keywords to the 
Working List does not automatically attach them to the records you are working with.
__________
See Also

Setting Options
Viewing Common Keywords
Adding Keywords to the Master Keyword List
Modifying Keywords in the Master Keyword List
Deleting Keywords from the Master Keyword List
Adding Keywords to the Working List
Removing Keywords from the Working List
Attaching Keywords to Records
Detaching Keywords from Records
Closing the Keywords Dialog
Keywords View
Keywords Command



Setting Options

The first time you open the Keywords Dialog you should open the Keyword Options and set 
them to match your personal workflow. Keyword Options are system preferences.

To open the Keyword Options, click the OPTIONS button in the Keywords Dialog. 

There are two options available in the Keyword Options dialog:

Edit Master Keywords - If this option is selected you can edit the Master Keyword 
List by adding, modifying, or deleting keywords. If this option is not selected, you 
cannot make any modifications to the Master Keyword List.

Copy To Working List - This option is only available if the Edit Master Keywords 
option is selected. If this option is selected, any keywords that you add to the Master 
Keyword List are automatically added to the Working List.

The default setting is both options selected. When you have finished setting the options, 
click the OK button. 
__________
See Also

Keywords Dialog
Keywords View



Viewing Common Keywords

To view those keywords that the records in your selection all have in common, click the 
COMMON button. 

The Common Keywords Dialog appears displaying only those keywords that are in every 
record in the selection. If there is only one record in your selection, all of the keywords from 
that record will be listed.

The common keywords can be added to the Working List in the Keywords Dialog. You may 
want to do this to see which keywords have already been attached to the records or in order 
to remove some or all of them from the selected records.

To add the common keywords to the Working List:
1. Select those keywords that you want to add to the Working List.

If you want to select them all, click the SELECT ALL button.
2. Click the OK button.

This returns you to the Keywords Dialog with the selected keywords placed in the Working 
List.
__________
See Also

Keywords Dialog
Keywords Command



Adding Keywords to the Master Keyword List

The Master Keywords List contains all of the keywords in the collection. A keyword must be 
on the Master Keyword List before it can be added to a record.

To add a keyword to the Master Keyword List:
1. Click in the edit box directly above the Master Keyword List.

2. Type in a new keyword.

3. Click the CREATE button or press ENTER.

The keywords you enter are placed in alphabetical order in the Master Keyword List. If you 
have selected the COPY TO WORKING LIST option from the Keyword Options, they are also 
placed in the Working List. Repeat this process as many times as necessary.
__________
See Also

Modifying Keywords in the Master Keyword List
Deleting Keywords from the Master Keyword List
Keywords Dialog
Keywords View
Keywords Command



Modifying Keywords in the Master Keyword List

When you modify a keyword in the Master Keyword List, the change is immediately reflected
in the Working List and in all records to which that keyword has already been attached. You 
can only modify keywords one at a time.

To modify a keyword in the Master Keyword List:
1. Select the keyword you want to modify.

2. Click the MODIFY button.
A Modify Keyword dialog appears.

3. Type the modified keyword into the New Value field.

4. Click the OK button.
__________
See Also

Adding Keywords to the Master Keyword List
Deleting Keywords from the Master Keyword List
Keywords Dialog
Keywords View
Keywords Command



Deleting Keywords from the Master Keyword List

Any keyword that you remove from the Master Keyword List is automatically removed from 
the Working List and from all records to which it has already been attached. 

To remove a keyword or group of keywords from the Master Keyword List:
1. Highlight the keyword(s) that you want to remove.

2. Click the DELETE button.
A warning appears asking if you really want to delete these keywords from the Master
Keyword List.

3. Click the OK button to delete the keywords you've highlighted.
__________
See Also

Adding Keywords to the Master Keyword List
Modifying Keywords in the Master Keyword List
Keywords Dialog
Keywords View
Keywords Command



Adding Keywords to the Working List

Keywords must be place in the Working List before they can be attached to records. Clicking 
the ATTACH button located below the Working List adds the keywords in the Working List to 
the records in your selection.

To add keywords to the Working List from the Master Keyword List:
1. Highlight the keyword(s) in the Master Keyword List that you want to add 

to the Working List.

2. Click the COPY button located between the Master Keyword List and the 
Working List.
The selected keywords are added to the Working List.

Double clicking a keyword in the Master Keyword List also adds it to the Working List.

If you have selected the COPY TO WORKING LIST option from the Keyword Options, any 
keyword that you add to the Master Keyword List is automatically added to the Working List.

Keywords can also be added to the Working List from the Common Keywords dialog.
__________
See Also

Removing Keywords from the Working List
Keywords Dialog
Keywords View
Keywords Command



Removing Keywords from the Working List

To remove keyword(s) from the Working List:
1. Highlight the keyword(s) in the Working List that you want to remove.

2. Click the REMOVE button.
__________
See Also

Adding Keywords to the Working List
Keywords Dialog
Keywords View
Keywords Command



Attaching Keywords to Records

Keywords must be placed in the Working List before they can be attached to the records in 
your selection.

To attach the keywords in the Working List to the records in your selection, click the ATTACH 
button.

Note: If a keyword already exists in a specific record it is not duplicated.
__________
See Also

Keywords Dialog
Keywords View



Detaching Keywords from Records

Keywords that you want to remove from the records in your selection must be in the Working
List.
To detach all of the keywords in the Working List from the records in your selection, click the 
DETACH button.
__________
See Also

Keywords Dialog
Keywords View



Closing the Keywords Dialog

When you are finished, click the CLOSE button to close the Keywords Dialog and return to 
the view from which you started.

If there are keywords in the Working List that have not been attached or detached when you 
click the CLOSE button, a warning appears reminding you that the keywords in the Working 
List have not been attached or detached and asking if you want to close the Keywords 
Dialog anyway. Click the YES button to close the dialog.
__________
See Also

Keywords Dialog
Keywords View



Keyword Search

Keywords are most often used to facilitate retrieval. For example, if you use keywords to 
describe the images in your collection, you can find all of the images that associated with 
fish by performing a keyword search for all of the records that have been assigned the 
keyword 'fish'. If you have assigned keywords consistently and accurately, this search will 
locate all of the images in your collection that contain fish.

The Keyword Search dialog can be opened from any view. To open the Keyword Search 
dialog, select KEYWORD SEARCH from the Browse menu or click the Keyword Search icon on 
the toolbar.
__________
See Also

Setting Search Options

Starting a Keyword Search

Keyword Search Command
Keywords View
Keywords Dialog



Setting Search Options

At the bottom of the Keyword Search dialog are a set of options. Set the options before you 
start the search.

AND - If you select AND, the search results will include only those records that 
contain all of the keywords you choose.
OR - If you choose OR, the search results will include those records that contain any 
one or more of the keywords you choose.

You may choose one, both, or neither of the next two options.
CREATE NEW PROJECT - If you want a project to be created and your search results 
placed in it, click the CREATE NEW PROJECT checkbox at the bottom of the Search 
dialog. If this option is not selected, the search results are displayed in the collection 
window. (This does not affect the actual contents of the collection. Selecting SHOW 
ALL from the Browse menu will show the entire collection again.)
SEARCH ACTIVE WINDOW - If you want your search to include only those records 
in the active window, click the SEARCH ACTIVE WINDOW checkbox at the bottom of 
the Search dialog. If this option is not selected, then the search includes all records in
the collection.



Starting A Keyword Search

To start a Keyword Search:
1. Set your search options.

2. Select from the Master Keyword List those keywords you want to include in 
your search.

3. Click OK to begin the search.
Double clicking a keyword in the Keyword Search dialog automatically starts a search 
for that keyword.



Searching and Sorting

Searching and sorting are ways of locating and organizing information within ImageAXS. 
ImageAXS provides multiple ways to both search and sort:

Full Search

Keyword Search

Sorting



 Full Search

Searching is a way to locate a specific record or records. The Full Search allows you to 
search the eight file information fields, the eight user definable text fields, and the Keywords
for each record.

To open the Full Search dialog, select SEARCH from the Browse menu or click the Search icon
on the toolbar.

__________
See Also

Setting Search Options
Creating A Search Line
Adding More Search Lines
Deleting A Search Line
Starting A Search
Search Command



Setting Search Options

CREATE NEW PROJECT If you want a project to be created and your search results 
placed in it, click the CREATE NEW PROJECT checkbox at the bottom of the Search 
dialog. If this option is not selected, the search results are displayed in the collection 
window. (This does not affect the actual contents of the collection. Selecting SHOW 
ALL from the Browse menu will show the entire collection again.)

SEARCH ACTIVE WINDOWIf you want to search only those records in the active window, 
click the SEARCH ACTIVE WINDOW checkbox at the bottom of the Search dialog. If 
this option is not selected, the search will include all records in the collection.

You may choose one, both, or neither of these options. To select or deselect an option, click 
the checkbox to the left of the option.



Creating A Search Line

The search criteria that you designate appear line by line in the Search List box. These lines 
are called search lines. An example of a Search Line might be: File Name contains tree.

The Search dialog also contains three boxes that are used to create search lines. The Fields 
box contains all searchable fields, the Comparators box contains the comparators (e.g., 
contains, is equal to), and the Value box is where you enter a specific value.

The search line that is currently being created or modified in the Search List box is 
highlighted. To create or modify a search line, select the desired components from the three 
boxes at the top of the dialog. Click in the box from which you want to make a selection, or 
use the TAB key to move from box to box. As each component of the search line is chosen, it
becomes highlighted and is added to the highlighted search line in the Search List box.

To select an item from the Fields box or the Comparators box, select the box and use the 
arrow keys to move to the item of your choice, or just click the item directly. To enter a value
in the Value box, select that box and type in the value for which you want to search. Each 
item that you select is displayed as part of a search line in the Search List box.
COMPARATORS: If the comparator you choose is "is less than" or "is less than or equal 
to", the search results include those records in which the field selected for searching is 
blank. If the comparator you choose is is equal to, the search results include only those 
values that EXACTLY match the value entered. The comparators contains and "begins with" 
allow for a more flexible search, but are considerably slower.

KEYWORDS: Although there is a separate search dialog specifically designed for performing
a Keyword search, you can search for records containing specific keywords from the Full 
Search dialog as well. If you select Keywords from the Fields box, the Comparators box is 
immediately reduced to a single option, 'is equal to', and the Values box becomes a 
scrollable list containing all of the keywords from the Master Keyword List. Select the 
keyword for which you want to search from the Values box. You can search for multiple 
keywords by creating multiple search lines.

TIME/DATE FIELDS: If you select a time or date field (e.g., File Modified, Acquire Date, etc.) 
from the Fields box, the Value box automatically becomes two separate boxes - one for date 
and one for time. The date box is formatted according to the country your Windows system 
is set for. For example, if you are using a British system, it will automatically be set to a 
Day/Month/Year format instead of the American Month/Day/Year format.



Adding More Search Lines

A search can be as simple or as detailed as you like. After completing a Search Line you 
have two choices. You can start the search by clicking the SEARCH button, or you can click 
the ADD LINE button to create additional Search Lines. 

If the ADD LINE button is clicked, an AND appears at the beginning of the search line that is 
added. However, this is only the default and you may change the AND to an OR by simply 
clicking the OR option to the left of the fields box. You may perform AND searches, OR 
searches, and AND/OR searches.

If you are performing a search with multiple lines and connectors, ImageAXS reads the 
search as you would a mathematical problem. For instance, the following:

Keyword is equal to beach
and Photographer is equal to Ansel Adams
or Keyword is equal to Yosemite
and Type is equal to Black & White

would be searched in the following way:

[(Keyword is equal to beach and Photographer is equal to Ansel Adams) or Keyword is equal 
to Yosemite] and Type is equal to Black & White.

This search will find:

1. All images that have been assigned the keyword: beach, that were taken by Ansel 
Adams, and that are Black & White.

2. All images that have been assigned the keyword: Yosemite and that are Black & 
White.

You can also use the Search History feature to add lines to a search. The Search History 
feature allows you to add entire searches that you have used previously. To open the Search 
History dialog, click the HISTORY button.

The Search History dialog contains a list of the first lines (or first two lines if the search was 
more than one line long) of the last 10 searches you performed. Searches are stored in the 
Search History dialog as many times as they are used.

To add the search lines from a previous search to the Search List box:

1. Click the HISTORY button.

2. Select the search you want to use again.

3. Click the OK button.
This places that entire search (not just the first line) in the Search List box. You may 
then modify it if you want.

Important! If you want to use search lines from the Search History dialog, you must add 
those lines FIRST since a search chosen from the Search History dialog will replace any 
search lines already in the Search List box.



Deleting A Search Line

To delete a Search Line:

1. Select the line you want to delete.

2. Click the CLEAR LINE button.

To delete all search lines at once, click the CLEAR ALL button. 



Starting A Search

To start a search, click the SEARCH button. 

If records are found that meet the criteria you designated, they are displayed in the view 
from which you opened the Search dialog or in a new project if you selected the CREATE 
NEW PROJECT option..

If no records meet the designated criteria, a No matches found message appears and the 
Search dialog remains so that you can try another search. Searches that result in a "No 
matches found" message are not added to the Search History dialog.



Sorting

Sorting allows you to organize the active window in whatever order you want. Projects can 
be saved in sorted order; however, sorts performed on collection windows are not saved 
unless you save the sorted collection as a project. Whenever you open a collection, the 
records are in default order (by the date they were acquired - most recent last) no matter 
what order they were in when you closed the collection.

Note: If you sort the records in a window (project window or collection window) and then 
add records to that window, the records are added to the end of the project or collection and
you must re-sort them to place the new records in the correct sort order.

There are two ways to sort records in ImageAXS:

Using the SORT Command

Drag and drop Sorting



 Using the Sort Command

The SORT command can be used from any view. Sorting with the SORT command organizes 
the records in the active window according to the information in the field that you choose as 
the Sort field. 

To perform a sort using the SORT command:
1. Select SORT from the Browse menu or click the Sort icon on the toolbar.

This brings up the Sort dialog.
2. Select the field that you want as your sort field.

3. Select either the ascending or descending option from the bottom of the 
dialog.
This determines the order in which the information is sorted.

4. Click the OK button.
The status bar reflects the progress of the sort.

The records in the active window are sorted (alphabetically, numerically, or chronologically) 
based on the information in the field you selected as your sort field, and are displayed in the
view from which you opened the Sort dialog.
__________
See Also

Drag and Drop Sorting
Sort Command



Monitoring

The monitoring feature in ImageAXS allows you to open a monitor windows in which you can
view a directory of files without acquiring those files into a collection. Monitoring means 
viewing the real-time contents of a directory. Any changes to the contents of the directory 
that you are monitoring are reflected in the monitor window.

Images from the files in the directory you have chosen to monitor are only displayed if they 
are thumbnails. Unlike images that are acquired into a collection, thumbnails are not created
for the images displayed in the monitor window. The monitor window reflects the contents of
a directory, it does not act upon those contents (e.g., by creating thumbnails).

Those files that will display as images in the monitor window are either    AFCP files or image 
files of a supported file type that are 128 x 128 pixels or smaller. An AFCP file is a .jpg file 
with a thumbnail attached. AFCP files are created by AXSs PhotoProcessor application. If an 
image file is not an AFCP file or an image file of a supported file type that is 128 x 128 pixels
or smaller, it is represented by a No Thumbnail image. Image files of unsupported file types 
and non-image files are represented by an Unreadable File image.

__________
See Also

Opening the Monitor Window
Viewing Images in the Monitor Window
Monitoring a Directory
Viewing Captions
Acquiring Files from the Monitor Window
Sorting the Monitor Window
Closing the Monitor Window



Opening the Monitor Window

To open the monitor window:
1. Select OPEN from the Monitor menu. 

A dialog appears prompting you to select a directory of files to monitor.
2. Select a directory to monitor.

You may select a directory from any drive available to your computer.
3. Click the OPEN button.

The contents of the directory you have chosen to monitor are displayed in the 
monitor window. If you have selected to filter out non-image files, there may be a 
slight delay between selecting a directory to monitor and the actual appearance of 
the images in the monitor window.

The monitor window is distinguished from other ImageAXS windows by the word "Monitor" in
it's title bar and by the sonar icon located at the top center of the window directly below the 
title bar.

Important! Only those files that are AFCP files or image files of a supported file type that 
are 128 x 128 pixels or smaller appear as images in the monitor window. All other files will 
appear as either No Thumbnail or Unreadable File images.

The name and location of the directory you are viewing are listed in the title bar of the 
monitor window. If monitoring is turned on, the window is dynamically updated to reflect any
changes to the corresponding directory. Updating occurs even if the monitor window is not 
the active window. 

When you open the monitor window, the files contained in the directory at the moment you 
open the monitor window are displayed in the monitor window in alphabetical order. Any 
files that are added to the directory while you are monitoring it are appended to the end of 
the files in the monitor window in arrival order. If files are added to the directory you are 
monitoring and you want to place them in alphabetical order, sort them using the SORT 
command or close the monitor window and open it again.

If files are being added to the directory you are monitoring (for example, you are 
downloading files from an online service) and monitoring detects an incomplete file (i.e., a 
file that is not yet fully downloaded), a 'Receiving' thumbnail appears in the monitor window 
until the file is fully downloaded. If you have your monitoring frequency set for intervals 
longer than 5 seconds, you may never see the 'Receiving' thumbnail.

__________
See Also

Viewing Images in the Monitor Window
Monitoring a Directory
Viewing Captions
Acquiring Files from the Monitor Window
Sorting the Monitor Window
Updating the Monitor Window
Closing the Monitor Window





Viewing Images in the Monitor Window

The monitor window has two views:

Thumbnails View

Text List View

These views function the same as in a collection window or project window except that they 
are not configurable. To move back and forth between the Thumbnails View and the Text List
View, use the Thumbnails View and Text List View icons on the toolbar or select the option of
your choice from the View menu.

Important! The views in the monitor window are not configurable.

__________
See Also

Views
Opening the Monitor Window
Monitoring a Directory
Viewing Captions
Acquiring Files from the Monitor Window
Sorting the Monitor Window
Closing the Monitor Window



Thumbnails View

Files from the directory you select to view will only display in the Thumbnails View if they are
AFCP files or image files of a supported file type that are 128 x 128 pixels or smaller. An 
AFCP file is a .jpg file with a thumbnail attached. AFCP files are created by AXSs 
PhotoProcessor application. If an image file is not an AFCP file or an image file of a supported
file type that is 128 x 128 pixels or smaller, it is represented by a No Thumbnail image. 
Image files of unsupported file types and non-image files are represented by an Unreadable 
File image.

__________
See Also

Views
Viewing Images in the Monitor Window



Text List View

The Text List View displays the file name, file size, file type, image height and width, and 
modified date for each file in the directory you are monitoring no matter what type of file it 
is.

__________
See Also

Views
Viewing Images in the Monitor Window



Monitoring a Directory

Monitoring is the process by which the monitor window is continually updated to reflect the 
real-time contents of the directory it is monitoring. If you are monitoring a directory and 
changes are made to the directory or its contents (e.g., files are added or removed), the 
monitor window automatically updates to reflect those changes.

The monitor window opens with monitoring on; however, you can turn it off. The sonar icon 
at the top center of the monitor window indicates whether monitoring is on or off. If the icon 
is lit and moving, monitoring is on. Simply click the sonar icon to turn the monitoring on or 
off. If the contents of the directory you are viewing will not be changing you should turn the 
monitoring off as it ties up your processor and can create unnecessary network traffic if you 
are monitoring a directory across a network.

If the contents of the monitor window are incorrect (for example if files or directories have 
been renamed or moved outside of ImageAXS) you can update the contents of the monitor 
window with the Refresh command. Refresh also allows you to do manual monitoring if you 
do not wish to have the automatic monitoring turned on. To update a monitor window, select
REFRESH from the Monitor menu.

__________
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Viewing Captions

If any of the AFCP image files in the directory you are monitoring contain captions, you can 
read them from the monitor window. Below each image in the Thumbnail View and to the 
left of the file name in the Text List View of the monitor window is a caption icon. If no 
caption is attached to a file, the caption icon is blank. If a caption is attached to a file, the 
caption icon contains text. 

To view a caption, double click the caption icon or select a file and choose SHOW CAPTION 
from the Monitor menu. The SHOW CAPTION command is only available when a single image
is selected.

The text from the file you select appears in a Caption Window. This window can be resized to
display more or less text. Use the scroll bar to view text not currently displayed in the 
caption window. Click the OK button to close the caption window. You must close the caption 
window that is currently open before you can view the caption from another thumbnail or 
move to another ImageAXS window.

Caption text cannot be modified in ImageAXS, but it can be copied to the clipboard. To copy 
text to the clipboard, highlight the text you want to copy and press CTRL+C. The text is 
copied to the clipboard and from there it can be pasted into another application.

__________
See Also

Opening the Monitor Window
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Acquiring Files from the Monitor Window 

Files can be acquired directly from the monitor window into a collection.

To acquire files directly from the monitor window into a collection:
1. Select the files in the monitor window that you would like to acquire into 

the current collection.

2. Select ACQUIRE from the Monitor menu.

Files can also be acquired into the current collection by dragging & dropping. To do so, 
simply select the files you want to acquire and drag & drop them from the monitor window 
onto the collection window or, if the monitor window is maximized, onto the ImageAXS menu
bar. Images can also be acquired into the current collection by dragging & dropping them 
from the monitor window onto a project window.

Source Files can be moved as they are acquired from from the monitor window. For more 
information, please see Moving Source Files as they are Acquired.

__________
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Moving Source Files as they are Acquired

You can automatically move source files as you acquire them from the monitor window. If 
you want to move source files when you acquire them from the monitor window , you must 
set the Monitor Window Acquire Options. The Monitor Window Acquire options are located in 
the Monitor Settings dialog of the Preferences. To open the Monitor Settings dialog, select 
MONITOR SETTINGS from the Preferences sub-menu. 

Once you have set the Monitor Window Acquire Options, the source files for any files that 
you acquire from the monitor window will be moved to the directory that you designated. If 
ImageAXS attempts to move a source file and a file with the same name already exists in 
that location, the Confirm File Replace and Acquire dialog appears.

From this dialog you have the following options:
YES: Click this button to replace the existing file with the file being moved.
YES TO ALL: Click this button to replace the existing file with the file being moved 
and do the same for all remaining files in the selection.
NO: Click this button if you do not want to replace the existing file with the file being 
moved. If this option is selected, the file in question is not moved or acquired, and 
the move/acquire process moves on to the next file in the selection.
RENAME: Click this button to bring up the RENAME dialog. The RENAME dialog allows
you to rename the file being moved. Click the OK button when you are finished. The 
renamed file is then moved and acquired.
CANCEL: Click this button to cancel the move\acquire process for the file listed in the
Confirm File Replace and Acquire dialog and for all remaining files. 

Important! Those source files that you move disappear from the monitor window
because they are no longer in the directory that you are monitoring.

__________
See Also

Monitor Settings
Acquiring Files from the Monitor Window



Sorting the Monitor Window

When you open the monitor window, the files contained in the directory at the moment you 
open the monitor window are displayed in alphabetical order. This is merely the default sort 
order and you can sort the files in the monitor window by: File Name, File Size, or 
Modification Date. (i.e., the date that the file was created or last changed). Sorting the files 
in the monitor window does not in any way affect the source files in the directory you are 
monitoring. Any files that are added to the directory you are monitoring after you have 
sorted the contents of the monitor window are appended to the end of the files in the 
monitor window in arrival order. 

To sort the files in the monitor window:
1. With the monitor window open and active, select SORT from the Browse 

menu or click the Sort icon on the toolbar.
This brings up the Sort dialog.

2. Select the type of sort you want to perform (File Name, File Size, or 
Modification Date) by clicking the option of your choice.

3. Select either ASCENDING or DESCENDING from the bottom of the dialog.
This determines the order in which the files are sorted.

4. Click the OK button.



Deleting Source Files

You may want to delete files from the directory you are monitoring. This is available directly 
from the monitor window.

To delete source files from the monitor window:
1. Select the file(s) that you want to delete.

2. Select DELETE SOURCE FILES from the Record menu.
A warning appears informing you of the number of source files that will be deleted 
and asking if you want to continue.

3. Click the YES button to delete the source files.
Click the NO button to return to the monitor window without deleting any files.



Renaming Source Files

The name of a source file can be changed from the monitor window.

To change a source file name:
1. Highlight the file in the monitor window that corresponds to the source file 

whose name you want to change.

2. Select RENAME from the Record menu.
The Rename dialog appears.

3. Type the new file name into the 'File Name' box

4. Click the OK button.
This changes the source file name and the monitor window updates to reflect that 
change.

Important! If you change the name of a source file outside of ImageAXS (e.g., in the File 
Manger) the file will disappear from the monitor window and will not reappear unless you 
close the monitor window and open it again or use the REFRESH command.



Updating the Monitor Window

If the contents of the monitor window are incorrect (for example if files or directories have 
been renamed or moved outside of ImageAXS) you can update the contents of the monitor 
window with the REFRESH command. Refresh also allows you to do manual monitoring if you
do not wish to have the automatic monitoring turned on. To update a monitor window, select
REFRESH from the Monitor menu.

__________
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Closing the Monitor Window

To close the monitor window:
1. Make sure that monitor window is the active window.

2. Select CLOSE from the Monitor menu.

If the monitor window is left open when you quit ImageAXS, it will automatically be re-
opened the next time you start ImageAXS.

__________
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 Printing

Print Setup

Printing

Print Preview



Print Setup

The Print Setup dialog for ImageAXS is the standard Windows Print Setup dialog. To open the
Print Setup dialog, select PRINT SETUP from the File menu. 

Make any changes to the Print Setup dialog that you deem necessary and click the OK 
button.

__________
See Also

Print Setup Command



Printing

Printing is available from any view, however there are only three print formats - Thumbnails, 
Text List, and Source Image. Although you can access printing from the Info Sheet View and 
the Keywords View, you cannot print a report that looks like either of those views.

To print:
1. Select PRINT from the File menu or click the Print icon on the toolbar.

The Print dialog appears.
2. Select a printing format - Thumbnails, Text List, or Source Image - from the 

Print dialog.

3. Select which records to print.
You may choose to print all of the records in the active window (ALL RECORDS) or 
only those records you have selected (SELECTED RECORDS). If no records have been 
selected then the SELECTED RECORDS option is not available.

4. [optional] Click the PREVIEW button to open the Print Preview dialog.
The Print Preview dialog allows you to preview your printout and allows you to change
the orientation of your printout without having to open the Print Setup dialog. For 
more information about the Print Preview dialog, please refer to the following section.

5. Click the PRINT button from either the Print dialog or the Print Preview 
dialog.

__________
See Also

Print Command



Print Preview

Once you have set your printing options you may want to see how the records will look when
you print them out. To do so, click the PREVIEW button. The Print Preview dialog appears 
displaying the records you have chosen to print in the format you have chosen to print them.

Text List

Source Image

Thumbnails



Text List 

records in the Text List format, you can change the orientation to either Portrait or 
Landscape directly from the Print Preview dialog. Simply select the option of your choice. 

Changing the orientation (Portrait/Landscape) in the Print Preview dialog also changes the 
printing orientation and overrides the option you selected in the Print Setup dialog. 

The Print Preview dialog also allows you to page through the records which you have chosen 
to print. To do so, use the navigation buttons located above the PRINT button.

To print from the Print Preview dialog, click the PRINT button.



Source Image

The preview page in the Print Preview dialog is displayed in the orientation (Portrait / 
Landscape) that you set in the Print Setup dialog. If you are previewing records in the Source
Image format, you can change the orientation to either Portrait or Landscape directly from 
the Print Preview dialog. Simply select the option of your choice. 

Changing the orientation (Portrait/Landscape) in the Print Preview dialog also changes the 
printing orientation and overrides the option you selected in the Print Setup dialog. 

The Print Preview dialog also allows you to page through the records which you have chosen 
to print. To do so, use the navigation buttons located above the PRINT button.

To print from the Print Preview dialog, click the PRINT button.



Thumbnails

If you are previewing records in the Thumbnails format, the Print Preview dialog contains an 
OPTIONS button. 

Click the OPTIONS button to open the Options dialog.

From the Options dialog you can change the preview display orientation to either Portrait or 
Landscape. Simply select the option of your choice.

Changing the orientation (Portrait/Landscape) in the Print Preview dialog also changes the 
printing orientation and overrides the option you selected in the Print Setup dialog. 

In addition to setting page orientation in the Options dialog, you can set the grid size for 
your Thumbnails printout. This allows you to control the number of thumbnails printed per 
page. For example, by setting the grid size to print 10 thumbnails wide and 10 thumbnails 
high you can print 100 thumbnails per page. However, in order to be printed on 8.5 x 11 
paper, those thumbnails will be very, very small. 

You cannot set the width of the grid to less than 2 or more than 12 thumbnails, and you 
cannot set the height of the grid to less than 1 or more than 10 thumbnails. Thumbnails are 
scaled to fill an entire page. Therefore, the size of the printed thumbnails depends on the 
size of your grid.

The Print Preview dialog also allows you to page through the records which you have chosen 
to print. To do so, use the navigation buttons located above the PRINT button.

To print from the Print Preview dialog, click the PRINT button.
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Drag and Drop Features

Creating Projects

Launching an Image Editor



Drag and Drop Features

For ease of use ImageAXS contains many features that can be accomplished by dragging & 
dropping instead of using menu commands.

Opening A Collection

Acquiring Images

Sorting

Adding Records to a Project

Opening A File In Another Application



Opening A Collection

To open ImageAXS using drag & drop:
1. Open the File Manager.

2. Drag & drop a collection file (.col) over the ImageAXS.exe file.

Important! This only works if ImageAXS is not already open.



Acquiring Images

Images can be acquired into a collection by dragging & dropping them from either the file 
manager or the monitor window.

To acquire images from the File Manager using drag & drop:
1. With a collection open, open the File Manger and locate the source files you

want to acquire.
You can select individual files or entire directories.

4. Drag & drop the source files from the File Manager over the ImageAXS 
application window.
The source files are acquired and new records are added to the collection window. 
The new records are also added to the active project window if the collection window 
is not the active window.

To acquire images from the monitor window using drag & drop:
1. Open ImageAXS

2. Open the monitor window.

3. Select the images in the monitor window that you want to acquire.

4. Drag & drop the images from the monitor window to the collection window.
The source files are acquired and new records are added to the collection window.



Sorting

Drag & drop Sorting is only available from the Thumbnails View or the Text List View. 

To sort a collection using drag & drop:
1. Select the record(s) that you want to move.

2. Drag & drop the selection to the position you want. 
If you want to drag & drop to a position that is not currently shown in the window, 
dragging the records to the top or bottom of the window will scroll the contents up or 
down.



Adding Records to a Project

Dragging & dropping records onto a project is available from the File Manager, the monitor 
window, any open project, and all views except for the Source Image View.

To add records to a project using drag & drop:
1. Select the records (from the collection window or another project window) 

or files (from the File Manager or the monitor window) that you want to add
to the project.

2. Drag & drop the selection onto the project you want to add them to.
Records from the collection window or another project window are added to the 
project. Files from the File Manager or the monitor window are acquired and the new 
records are added to both the project window and the collection window.



Opening A Source File In Another Application

Just as you can acquire images into ImageAXS by dragging & dropping them from the File 
Manger, you can open source files in other applications by dragging & dropping records from
ImageAXS to other applications. The application you are dragging to must be a Windows 
drag & drop client or nothing will happen if you drop a record onto it. You can drag & drop 
records from every view except the Source Image View.

To open a file in another application:
1. The application you want to open files in must be open.

2. Select the record or records whose source files you want to work with.

3. Drag & drop the records onto the application in which you want to open 
them.
If the application is minimized, drag & drop the selected records over the icon 
representing the application.



Creating Projects

There are many different ways to create projects in ImageAXS. Listed below are ALL of the 
ways to create a project within ImageAXS. Keep in mind that any window other than the 
collection window is a project window.

1. Select NEW from the Project menu.
This opens a blank project that you can add records to.

2. Make a selection of records, select ADD TO from the Project menu, select 
NEW PROJECT from the dialog that appears.
This opens a new project containing the records in your selection.

3. Select the CREATE NEW PROJECT option when you perform a Search or a 
Keyword Search.
This opens a new project containing the results of your search.

4. Make a selection of records and double click on any of the view icons on the
toolbar. 
This opens a new project containing the records in your selection. The records are 
displayed in the view that corresponds to the icon you double clicked. If you double 
click a view icon from the Info Sheet View, Keywords View or Source Image View, the 
new project will contain only the record that you were viewing when you double 
clicked the icon.

The following are only available if the 'Double Click On View Creates New Project' option is 
selected in the System Settings section of the Preferences:

5. Double click a thumbnail in the Thumbnails View, the Info Sheet View, or 
the Keywords View.
This opens a new project containing only the record you double clicked. The record is 
displayed in the Source Image View.

6. Double click the field beneath a thumbnail in the Thumbnails View or any 
text in the Text List View.
This opens a new project containing only the record you double clicked. The record is 
displayed in the Info Sheet View.

7. Double click the Keywords field label in the Info Sheet View. 
This opens a new project containing only the record you double clicked. The record is 
displayed in the Keywords View.

__________
See Also

Double Click On View Creates New Project



Launching An Image Editor

ImageAXS provides image editing capabilities by way of the Launch Editor feature. With this 
feature you can launch editing applications from within ImageAXS.

The Launch Editor feature makes use of the Windows Associate feature which allows you 
to associate certain applications with specific file types. For instance, Windows comes with 
an application called Paintbrush that is automatically associated with .bmp files. Therefore, if
you select a record in ImageAXS whose source image is a .bmp and select LAUNCH EDITOR 
from the Edit menu, Paintbrush opens the source image and you can edit the image. You 
must associate applications to file types before the Launch Editor feature will work.

The Launch Editor feature is especially useful for viewing AVI movie files and playing WAV 
sound files. ImageAXS can acquire AVI and WAV files, but cannot display or play them.

To launch an editing application from within ImageAXS:
1. Select a record whose source image you want to edit.

2. Select LAUNCH EDITOR from the Edit menu.
If an application has been associated with the file type of the source file for the 
record you selected, that application will open the source image for the selected 
record. If no application had been associated with the file type of the source file for 
the record you selected, a dialog appears to inform you that no application has been 
assigned. Click the OK button to dismiss the dialog.

Holding down the CONTROL and SHIFT keys and double clicking on a thumbnail in the 
Thumbnails View, Info Sheet View, or Keywords View has the same effect as steps one and 
two above.

If you make changes to a source image, the record associated with that image will have to 
be updated in order for the thumbnail to reflect the changes.

__________
See Also

Launch Editor Command



Toolbar Icons 
(for more information about each feature, click the icon)

 New Record: Creates a new record that is not yet associated with a source file.

 Save: Saves changes you have made to the current record.

 Keywords: Opens the Keywords Dialog.

 Print: Opens the Print dialog.

 Thumbnails: Displays the records in the active window in the Text List View.

 Text List: Displays the records in the active window in the Text List View.

 Info Sheet: Displays the records in the active window in the Info Sheet View.

 Keywords: Displays the records in the active window in the Keywords View.

 Source Image: Displays the records in the active window in the Source Image View.

 First: Navigates to the first record or window of records in the active window.

 Previous: Navigates to the previous record or window of records in the active window.

 Next: Navigates to the next record or window of records in the active window.

 Last: Navigates to the last record or window of records in the active window.

 Keyword Search: Opens the Keyword Search dialog.

 Search: Opens the Search dialog.

 Sort: Opens the Sort dialog.

 File Info: Opens the File Info dialog.
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Collection
Collections are the database files created and read by ImageAXS. Each collection is 
an imagebase composed of up to 32,000 individual records. ImageAXS allows you to 
create and maintain as many different collections as you like; however, only one 
collection can be open at a time.



Record
Each collection or project you create is made up of individual records. A record 
contains information about a single source file. To create a record, select a source file 
and acquire it. To create an empty record (one that is not yet associated with a 
source file), select NEW RECORD from the Record menu.



Caption

Text attached to an AFCP image file. If a source file contains a caption, the caption text is 
entered into the long text field when that source file is acquired into a collection. Captions 
can also be viewed from the monitor window.



Monitor Window

The monitor window is a window that you can open to view a directory of files without 
acquiring those files into a collection. The monitor window reflects the contents of the 
directory you are monitoring and therefore can only display thumbnails for those image files 
in the directory that already contain thumbnails. Any changes to the contents of the 
directory (e.g., files are added or removed) are reflected in the monitor window.



Windows Associate Feature

The Windows Associate feature allows you to associate certain applications with specific file 
types. For instance, Windows comes with an application called Paintbrush that is 
automatically associated with .bmp files. Therefore if you select a record in ImageAXS whose
source image is a .bmp and select LAUNCH EDITOR from the Edit menu, Paintbrush opens 
the source image and you can edit the image. You must associate applications to file types 
before the Launch Editor feature will work.

To associate file types with applications:
1. Open the File Manager.

2. Select ASSOCIATE from the File menu.

3. Type a file type in the FILES WITH EXTENSIONS field.

4. Select an image editing application from the Associate With box or click the
BROWSE button to select an application that is not listed.

5. Click the OK button.

Repeat this for as many file types as you want to work with. Only one application can be 
associated with each file type, but the same application can be associated with more than 
one file type.

__________
See Also

Launch Editor Command
Launching An Image Editor



Thumbnail
A thumbnail is a small representation (no side larger than 128 pixels) of a full size 
image. A thumbnail is created and included in a record instead of the full size image 
because full size images are very large and a database containing hundreds and 
thousands of full size images would be unusable.
Thumbnails can be displayed in the Thumbnails View of the collection window, the 
monitor window, or a project window as large thumbnails (128 x 128 pixels) or small 
thumbnails (80 x 80 pixels). The Info Sheet View and the Keywords View always 
display large thumbnails.



Clipboard
The Clipboard is a temporary storage area for text or graphics that you are copying or
moving from one location to another. The Clipboard is a common holding area among
Windows applications.



Acquire
In order to add an image to a collection you must 'acquire' a source file. Acquiring a 
source file does not physically bring the source file into the collection. What actually 
happens is that the program 'takes a snapshot' of the image in the source file and 
creates a smaller, thumbnail version of it that is then entered into a record in your 
collection. In addition to creating a thumbnail, the acquire process records certain file
and location information about the source file (file information) that is stored, along 
with the thumbnail, in the record. 



Imagebase
An Imagebase is a database of images.



Source File
A source file is an image file from which a record in ImageAXS is created. A source file
is usually a very large file and for this reason remains outside of ImageAXS. When a 
source file is acquired into a collection, a thumbnail is created and is placed in a 
record along with specific information about the source file. Each record in ImageAXS 
is linked to its source file and the full size image contained in the source file is 
available to be viewed from within ImageAXS.



Keywords
Keywords are descriptive words that you can include in a record to facilitate 
searching. Keywords are most commonly used to describe the image associated with 
a record.



View
A view is a way of looking at images and data in ImageAXS. There are five main views
in ImageAXS: Thumbnails View, Text List View, Info Sheet View, Keywords View, and 
Source Image View.



On-line
On-line refers to whether or not ImageAXS can locate the source file for a specific 
record. If the database reference is up to date and the source file can be located, 
then the source file is on-line.



Off-line
Off-line refers to whether or not ImageAXS can locate the source file for a specific 
record. If the source file cannot be located, then the source file is off-line. If a source 
file is off-line you will not be able to view the source image for that record.



Preferences
Preferences are options which allow you to customize certain areas of ImageAXS. 
Preferences may be set any time after a collection has been created; however, it is 
best to set them before any records are created.



User Definable Fields
User definable fields are enterable data fields which you can name. There are eight 
user definable fields in ImageAXS - seven short fields (79 characters) and one long 
field (32,000 characters).



Collection Preference
A collection preference is a preference that is saved specifically with the collection 
that is currently open and that applies only to that collection. Assigning Field Labels 
and Selecting A Thumbnail Label are collection preferences.



System Preference
A system preference is a preference that is saved in the Windows directory and that 
applies to any collection you open.



Master Keyword List
The Master Keyword List contains all of the keywords in the collection.



Active Window
Although you may have one collection window and many project windows open at a 
time, only one window can be 'active' at a time. If you have only one window open, 
that window is always the active window. If, however, you have more than one 
window open, the title bar of the active window is highlighted. If you have a dialog 
open, the active window is the window that was active when you opened the dialog.



Selection
A selection is a record or group of records that you have singled out to work with. In 
the Thumbnails View and the Text List View the record or records included in a 
selection are highlighted with a red border.
You can select records individually or you can select groups of records. Groups of 
records can be selected from the Thumbnails View or the Text List View. The Info 
Sheet View, Keywords View, and Source Image View, however, are single image views
that display one record at a time, and therefore you are always working with a 
selection of one. It is not possible to select multiple records from single image views.



Keyword Working List
The Keyword Working List contains the keywords that you have chosen to attach to or
detach from the selected record or group of records. The Working List is only 
available from the Keywords Dialog.



Database References
Each record in a collection is linked to its source file by way of a database reference. 
The database reference is information within the database which keeps track of the 
location of each source file.



Batch Update
The Batch Update feature allows you to update multiple records at once.



Search Line
A search line is a line of your search. The following search, for example, has 3 search 
lines:

Keyword is equal to transportation
and Keyword is equal to automobile
and Keyword is equal to truck



Project
A project is a saved sub-set of a collection. Placing records in a project does not 
remove them from the collection or change their physical location at all. It simply 
tags them as belonging to a specific group and allows them to be called up quickly 
and easily.



File Information
File Information is non-modifiable information about the source file for the selected 
record. File information is entered into a record when a source file is acquired or 
updated. File Information includes the following information about the source file: File 
Name, File Type, File Size, Image Width, Image Height, File Modified, Volume Name, 
and File Location.
To display the file information for a record, select a record and choose FILE INFO from 
the Record menu, click the File Info icon on the toolbar, or double click on the disk 
icon in any view. The FILE INFO command is only available if a single record is 
selected. To close the File Information dialog, click the OK button.



Supported File Types

ImageAXS supports (i.e., can acquire and create thumbnails for) files of the following file 
types:

GIF
PCX
BMP

TARGA
DCX
TIFF
EPS
WMF
WPG
PICT
JPEG
JIF

PhotoCD (PCD)
Specifics regarding our support of these file types are included in the descriptions of the file 
types themselves.
AVI movie files and WAV sound files can be acquired; however, a sound icon or a movie icon 
is displayed instead of a thumbnail. You can view AVI movie files and WAV sound files with 
the Launch Editor Command.

Files other than those listed above (e.g., text files) can be acquired; however, they appear as
'Unreadable file' thumbnails.

__________
See Also

Creating Records
Launching An Image Editor



GIF
Format originator: CompuServe Inc.

5000 Arlington Center Boulevard
Columbus, OH 43220

File Extension: GIF
Maximum colors: 256
GIF - the graphics interchange file format. Uses the LZW compression used in the TIFF file 
format except that the bytes are reversed and the string table is upside down. All GIF files 
have a palette. Some GIF files can be interlaced in that raster lines can appear as every 4 
lines then every 8 lines then every other line. This is due to GIF files usually being received 
from a modem.



PCX
Format originator: ZSoft Corp.

450 Franklin Road, Suite 100
Marietta, GA 30067

File extension: PCX
Maximum colors: 16.7 million
PCX - the pcx file format is a simple run length encoded format. If the two most significant 
bits of a byte are high then the other bits represent a run of the next byte used as the color. 
If the two highest bits are not set then it is the color itself. PCX files can be 1 ,4, 8 or 24 bits 
per pixel.



BMP
Format originator: Microsoft Corp.

16011 NE 36th Way
Box 97917
Redmond, WA 98073

File extension: BMP
Maximum colors: 16.7 million
BMP - Bmp files can be compressed or uncompressed. The uncompressed type are simply 
raw data that is always on a boundary of 4 bytes per raster. The compressed is similar to the
pcx run length encoded technique, with minor variations. Only 4 and 8 bit files can be 
compressed. A bmp is simply a windows dib with another file header on top of it. 1, 4, and 8 
bit images always have a palette. 24 bit images never can have a palette. Bmp files are 
always stored upside down in that it starts with height -1 and continues to raster 0.



TARGA
Format originator: Truevision Inc.

7340 Shadeland Station 
Indianapolis, IN 46256

File extension: TGA
Maximum Colors: 16.7 million
TGA - the Targa file format. These are usually 15 or 24 bit full color files. They may be 8 bit 
grayscale or simple run length encoded files. Targa files may be upside down or right side up
as indicated in the header.



DCX
Format originator: Intel
File Extension: DCX
Maximum colors: 16.7 million
DCX - This file type is simply multiple PCX images in a single file. The file contains a header 
with offsets to each image (page).



TIFF
Format originators: Aldus Corp.

411 First Avenue South
Seattle, WA 98104

Microsoft Corp.
16011 NE 36th Way
Box 97917
Redmond, WA 98073

File extension: TIF
Maximum colors: 16.7 million
TIFF - Tiff stands for the tagged image file format. There are a total of 45 possible tags 
which represent height, width, bits per pixel. Other tags include compression used, color 
tables, and aspect ratio information. A tiff file will usually not contain more than 20 tags. The
tiff specification has recommendations for required tags. A tiff file will contain 1 of several 
compression types. The types are:

Uncompressed - No compression. Can be used for 1, 4, 8 and 24 bit images.
Pack Bits - Similar to Macintosh pack bits. A simple run length encoded scheme. Can
be used for 1 bit images.
Modified Huffman - This is a serial run length encoded technique. After a run is 
found it is encoded as a code of 3 to 12 bits representing black or white and the run 
size. This stream is packed serially into the file. Can be used for 1 bit images.
Lempel Ziff Welch - Commonly known as LZW. This technique uses runs and puts 
them into a string table. If the run is new it is written into the output file. When 
decompressing the string table is rebuilt. Can be used for 1, 4, 8, and 24 bit images.
Group III / Group IV - Group III and Group IV compression is used for black and 
white images only and are used mostly for fax images. Group III images have a fixed 
width of 1728 pixels. These compression schemes are commonly used in TIFF-F class 
files.



EPS
Format originator: Adobe Systems Inc.

1585 Charleston Road
Mountain View, CA 94039

File extension: EPS
Maximum colors: 16.7 million
EPS - EPS (PostScript) files can contain image data as vectors and bitmaps as well as a 
screen preview image usually in TIFF format. The Image Format Library allows you to 
retrieve the screen display image only. The Image Format Library does not interpret 
PostScript language commands.



WMF
Format originator: Microsoft Corp.

16011 NE 36th Way
Box 97917
Redmond, WA 98073

File extension: WMF
Maximum colors: 16.7 million
WMF - WMF is the Windows metafile format. It is simply searched for a record which is a 
DIB. This is the same as the BMP file format except the first file header is missing. The WMF 
bitmap may be compressed for the 4 and 8 bit images.



WPG
Format originator: WordPerfect Corp.
File Extension: WPG
Maximum colors: 256
WPG - This is the WordPerfect metafile format. It is also searched for a bitmap record as is 
the WMF file format. The bitmap file format is a simple run length encoded format.



PICT
Format originator: Apple Computer Inc.
File extension: PCT, PIC
Maximum colors: 16.7 million
PICT - This is the most commonly supported format for the Macintosh. This is a metafile 
format and can contain both vector and bitmap information. The Image Format Library 
supports raster images contained in version 1 and version 2 files.



JPEG
Format originator: Joint Photographic Experts Group
File extension: JPG, JIF
Maximum colors: 16.7 million
JPEG - This is the only lossy compression format supported by the Library. This means that 
some data is modified to achieve greater compression. This can sometimes also improve the
quality of the image when decompressed. JPEG is still an emerging standard and many 
variations are already in use. JPEG is usually the best way to compress 24 bit images and 
allows images to be compressed to any size versus quality ratio.



Scanning

If the ImageAXS and Nikon plug-ins are in the correct directories, ImageAXS can call up the 
Nikon Control application, and images scanned with Nikon scanners (Coolscan, LS-3510AF, 
or LS-3510AF with Maron Autofeeder) can be acquired into ImageAXS as they are saved to 
disk. Both the ImageAXS and the Nikon Control plug-ins are distributed by Nikon. For more 
information please refer to your Nikon Control User's Manual or contact Nikon at 516-547-
4311.

If the Nikon Control plug-in (opennknc.plg) is in the same directory as ImageAXS when you 
start ImageAXS, the SCAN command appears on the File menu in ImageAXS. Select SCAN 
and OPEN NIKON CONTROL to access the Nikon Control application from within ImageAXS. If 
the Nikon Control application is not already running, it is launched. If it is already running, it 
is brought to the front. If the Nikon Control application cannot be found, a dialog appears 
prompting you to locate it.

If the ImageAXS plug-ins (autolodr.pin, openiaxs.pin, and sendiaxs.pin) are in the same 
directory as the Nikon Control application, the following features are added to the Nikon 
Control application:

- the OPEN IMAGEAXS and ADD TO IMAGEAXS menu items appear on the Edit menu.

- the NEW AUTOLOADER SCAN menu item on the File menu is enabled.

- an ADD TO IMAGEAXS checkbox is added to the Save dialog.

These features allow you to acquire images directly into ImageAXS as they are scanned. For 
more information about these features, please refer to your Nikon Control User's Manual.




